Hedera Hashgraph Training Materials




Prerequisites
Get a Header Testnet account.
Create a Hedera Training directory, called hederaTraining.

Navigate to https://portal.hedera.com

Complete the account form and click Sign Up

@ Hedera Portal x +

d C & 0 & https;//portal hedera.com/register o | TP A

@ HederaHashgraph

Hedera Developer Portal Q@

Start building fast and secure decentralized

applications powered by Hedera Hashgraph. testmail@gmail.com

Find an hbar supported wallet to instantly createa |,

Hedera mainnet account.

United States of America v
United States of America v
Developer ~

By creating a Hedera profile you agree to the
Terms Of Service .

SIGN UF



about:blank

Click Create Account. For now, select Tested. A Mainnet account will need to be created. However, for
now the Testnet will be used.

Welcome to | Testnet A

CREATE TESTNET ACCOUNT GET A MAINNET ACCOUNT

Create your Hedera account on this testnet. This Complete identity verification to create a
account will have its balance topped up to 10,000 HBAR Hedera mainnet account to have an hbar

every 24 hours. wallet, use and run applications.

CREATE ACCOUNT BEGIN

Switch to Previewnet

MANAGED MIRROR NODE APIS

For a full list of Hedera official and
community supported mirror node APIs,
used for application development on the
testnet and mainnet, please visit:
https://hedera.com/explorers



Testnet account credentials will be returned:

e accountId
e public key
e private key

Testnet node addresses will also be returned.

Welcome to | Testnet v

YOUR HEDERA AGGOUNTS

ADDRESS
.testnet.hedera.com:50211

.testnet.hedera.com:50211

.testnet.hedera.com:50211

[ N N =]

.testnet.hedera.com:50211

"accountId": "0.0.2084028",
"publicKey": "302a300506032b6570032100665edbé
"privateKey": "302e020100300506032b6570042204
}
2
NETWORK

HoDE
0.0.3
0.0.4
0.0.5
0.0.6

GET A MAINNET AGGOUNT

Complete identity verification to create a

Hedera mainnet account to have an hbar

wallet, use and run applications.

MAMAGED MIRROR NODE APIS

For a full list of Hedera official and
community supported mirror node APls,
used for application development on the
testnet and mainnet, please visit:
https://hedera.com/explorers



Copy account information to the buffer. Click the copy button

YOUR HEDERA ACCOUNTS

"accountId": "0.0.2084028",
"publicKey": "302a300506032b6570032100665edbé
"privateKey": "302e020100300506032b6570042204

Paste the Testnet account information to a text file and save it in the hederaTraining directory.

] accounts.txt - Notepad - |
File Edit Format View Help
{
"operator”: {
"accountId”: "©.0.2084028",
"publicKey": "302a300506032b6570032100d32d7e55de28c69527e2a7d145b717df@73216214499801b9%e42a3ccbaralss7z”,
"privateKey": "302e020100300506032b657004220420b7049e4530795d17a79e713c0583dbpaleacac18de68dT719F1b89aBc658bc3™
s
"network™: {
"@.testnet.hedera.com:56211": "0.8.3",
"1.testnet.hedera.com:50211": "0.0.4",
"2.testnet.hedera.com:56211": "0.80.5",
"3.testnet.hedera.com:50211": "90.0.6"
3
¥

Ln 12, Col 6 100%  Windows (CRLF) UTF-8




There are advantages to keeping your account data in a text file opened with Sublime, Notepad++ or
similar high feature text editor application. This will allow quick access to data with many user features.

E C\hederaTraining\accounts.txt - Sublime Text (UNREGISTERED) - O X
File Edit Selection Find View Goto Tools Project Preferences Help

4F  acco

I
1§

"operator”: {
"accountId”: "0.0.2084028",
“"publicKey": "302a300506032b6570032100d32d7e55de28¢c69527e2a7d145b717d10
732f6e14499801b9e42a3ccba®alss>7",
"privateKey": "302e020100300506032b657004220420b7049e4530795df7a79e7f3c
0583db0al04cAc18de68dt719f1b89aBcE58bc3”
b
"network™: {
"@.testnet.hedera.com
"1.testnet.hedera.com:50211
"2.testnet.hedera.com:50211
"3.testnet.hedera.com:50211":

I[] Line 13, Column 2 Spaces: 4 Plain Text
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| | = | C\hederaTraining

Home Share View

— v T « Win.. ** hedera.. ~ O 2 Search hederaTraining

Lt

hederaTraining ~ [] Name

| accounts.txt

Install IntelliJ
Step 1.

Download IntelliJ: https://www.jetbrains.com/idea/download

Step2

Install Java version 11, https://www.oracle.com/java/technologies. Java Version 11, is the minimal
version

IntelliJ Step 1.

Start ItelliJ and click New Project

#8 Welcome to Intelli) IDEA - O X

O emm it e B
IntelliJ IDEA (4 |Search projects Mew Project Open Get from VCS

or

Create a new Project. Click File -> New -> Project ...

ﬂ jZlCl Edit View Navigate Code Refactor Build Run Tools VCS Window Help
He > Project... l
= Open.. Project from Existing Sources... _
% Open Recent > Project from Version Control... '
; Close Project Module... I
Close All Projects Module from Existing Sources...

Close Other Projects = Scratch File Ctrl+Alt+Shift+Insert
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Select Gradle
In Additional Libraries and Frameworks, check Java

In Project SDK, select at least version 11.

a‘ New Project

u Java Project SDK: = 11 version 11.0.

l Kotlin DSL build script

ditional Libraries and Frameworks:

= Android
. . p Java ]
Intelli) Platform Plugin
m Ear
& JavaFX ® Groowy

& Java Enterprise Intelli) Platform Plugin

H; Kotlin/JS for browser
I Kotlin/IS for Nodejs

% Spring Initializr
#) Quarkus

L Micronaut K Kotlin/vM
MicroProfile B Kotlin/Multiplatform

@ Ktor =~ Web

& Groowy

Grails App Forge
I Kotlin

Web
JavaScript

« Empty Project

Previous | m | Cancel Help

~———

Click Next



For Name, enter HederaExamplesAPI
Click Finish.

Bl New Project

Name: ederaExampIesAPI|

Location:  ~\ldeaProjects\HederaExamplesAPI

» Artifact Coordinates

Previous @ Cancel

Help




IntelliJ Step 2.

If prompted, for this exercise, select This Window

e Open Project

Where would you like to open the project ‘HederaTokenService'?

Don't ask again

This Window

Mew Window Cancel

If the Tip of the Day opens, click Close

ﬂ' Tip of the Day

To join two lines into one and remove unnecessary spaces, press Ctrl+shift+].

Don't show tips Previous Tip [ Close




IntelliJ Step 3.

Double click on and open the project level build.gradle file.

HederaExamplesAPI build.gradle

Project %,

™

deaProj

r Project

v . HederaExamplesAPl ' sers)im
> .gradle
b Idea
> gradle
v SIC
7, main
2 test

build.gradle

gradlew

= gradlew.bat
settings.gradle
2 'l External Libraries

> “gy Scratches and Consoles

il



IntelliJ Step 4.

Copy-Paste all source code from GitHub: build.gradle
https://github.com/theblockchainacademy/Hedera/blob/main/build.gradle

The build.gradle file may not correctly paste into the IntelliJ project. As stated, use the source from
GitHub.

build.gradle file:
//start build.gradle file
plugins {

id 'java'

group 'org.example'

version 'l.0-SNAPSHOT'

repositories {

mavenCentral ()

dependencies {
//implementation 'com.hedera.hashgraph:sdk:2.0.13"
implementation 'com.hedera.hashgraph:sdk:2.1.0'
//implementation 'com.hedera.hashgraph:sdk:2.1.0-beta.l'

implementation 'io.github.cdimascio:java-dotenv:5.2.1' // Module
that stores your environment variables from a .env file

implementation "com.google.code.gson:gson:2.8.8"
implementation "org.slf4j:slf4j-simple:1.7.32"
implementation "io.grpc:grpc-netty-shaded:1.40.1"

implementation "com.google.errorprone:error prone core:2.9.0"
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test {

useJUnitPlatform()

Jjava {

sourceCompatibility org.gradle.api.JavaVersion.VERSION 11

targetCompatibility org.gradle.api.JavaVersion.VERSION 11

tasks.addRule ("Pattern: run<Example>: Runs an example.") { String
taskName ->

if (taskName.startsWith ("run")) {
task (taskName, type: JavaExec) {
classpath = sourceSets.main.runtimeClasspath
main = (taskName - "run") + "Example"

standardInput (System.in)

// NOTE: Uncomment to enable trace logs in the SDK during
the examples

// jvmArgs "-
Dorg.slf4j.simplelLogger.log.com.hedera.hashgraph=trace"

}

}
//end build.gradle file

Paste the dependency text into the project’s build.gradle file using the source from GitHub.


about:blank

IntelliJ Step 5.

Click File -> Save All menu, or tap ctrl + s to save the project,

File Edit View MNavigste Code Refactor Build Run Tools VCS Window Help

HederabsamplesAP1

I Project

>
>

build.gradle
Project ~ @ = o —
% HederaBxamplesAPl -\ Users'jim\|deaProjects) Hed erabrampl.

gradle

>
> I idea
> I gradle

src

% main
& test
build.gradle

gradlew

2 gradlewbat
settings.gradle

1lli External Libraries

 Scratches and Consoles

build.gradle (HederaExamplesAPl)

HederaExamplesAP| - build.gradle (HederaExamplesAPI)

plugins {
id 'java*

group 'org.example’

version '1.8-SNAPSHOT'

repositories {
mavenCentral()

» - dependencies {

implementation

implementation
implementation

'com.hedera.hashgraph:sdk:2.1.0"

n ‘cem.hedera.r 2.1.0

'ic.github.cdimascio:java-dotenv:5.2.1' // M
"com.google.code.gson:gson:2.8.8"

implementation "org.slf4j:slf4j-simple:1.7.32"
implementation "io.grpc:grpc-netty-shaded:1.40.1"
implementation "com.google.errorprone:error_prone_core:2.9.6"

+

» test {

useJUnitPlatforn()

}

java {
sourceCompatibility = org.gradle.api.JavaVersion.VERSION_11
targetCompatibility = org.gradle.api.JavaVersion.VERSION_11




Update the dependencies using Gradle

In Intelli)’s upper right corner, look for the Gradle tab button and click it.

X~ A, Add Cenfiguration... - Q o« D
_
-
G
I ¥4 A~ v] o
(=1
=
2, _—
g
g
i
IntelliJ Step 6.
The Gradle tools will open.
Click the Reload All Objects button
Gradle 2 — =
_— E
T o | = = k1 £ 2
o
eload All Gradle Projects =
» Uy Tasks
4l Dependencies el
&
il compileClasspath =
)

il runtimeClasspath

il testCompileClasspath

T T T ¥

il testRuntimeClasspath




Once the updated is completed, you can expand the Dependencies and view the class paths.

Click the Gradle tab button to close the Gradle tools.

Gradle S — =

— . o

S + & = T g 4 L 2

o

HederaAP| E
» B Tasks

4

@

# [l compileClasspath =

~ Uil runtimeClasspath o

Il com.google.code.gson:gson:2.8.8
» |l com.google.errerproneierrer_prone_cor
# |l com.hedera.hashgraph:sdk:2.1.0

Il io.github.cdimascioijava-dotenv:5.2.1

Il io.grpo:grpe-netty-shaded:1.40.1

I org.sifdjisifdj-simple:1.7.32
i testCornpileClasspath

W

# Uil testRuntimeClasspath

The Hedera SDK 2.1.X will appear in the dependencies, along with other dependencies.



Intelli) Step 7.
Create an environment file.

Right click on the project level, click New -> File

HederaExamplesAPI build.gradle

5 Project hm =z = | & — build.gradle (HederaFxamplesAPI)
é‘ L4 Hede Exa PI T I T YT N YN A TN TN N ST TR TN : -
n'[ = rabamplesh Module
in # .gradle
5 idea Add Framework Support...
X gradle 3¢ Cut Cirl+X | BB Sfratch File Ctrl+Alt+Shift+Insert
W Sre B Copy Ctrl+C Directory
> [ main Copy Path/Reference... o HTML File
> g test [ paste Ctrl+V  ess Stylesheet
build.gradle Find Usages Alt+F7 s JavaScript File
gradlew Find in Files.. Ctrl+ Shift+F  ima TypeScript File
= gradlew.bat Replace in Files... CirleShift+p | =) package.json File
settings.gradle Analyze 5 7 OpenAP| Specification
# b External Libraries Refactor 5 Ik Kotlin Script
# Yy Scratches and Consol ¢ Kotlin Worksheet
Add to Favorites » ) )
Swing Ul Designer
Reformat Code Ctrl+Ak+L
111 Resource Bundle
Optimize Imports Ctrl+Alk+Q e e e e

The New File dialog box will open, enter .env into the Name field and press the Enter key.

Note: This same .env file is used in the upcoming exercises, 1 -6

Mew File

.emri



If prompted, select Text for the file type, and click OK.

ﬂ Register New File Type Association X
The file "hello’ is not associated with any file type. Please define the association:
File pattern:  .hello v

To change the association later, go to Settings | File types | Text

Open matching files as text and auto-detect file type by content, e.g. hashbang

Open matching files in Intelli) IDEA:

151 Typescript

1+ TypeScript config

tex Typescript JSX

O Velocity template

wm XHTML

e AML

o AML Document Type Definition
e YAML

‘. Yarn lock

Open matching files in associated application

? CanCEI




The .env file will open in the editor view and appear listed at the same level, the root level, as the
build.gradle file in the Project view.

Project -

[t e

A HederaTokenService

-
W

.gradle
b JAdea

’ gradle
V &I

» main
¥ test

LN

build.gradle

gradlew

gradlew.bat
settings.gradle
# |l External Libraries

by Scratches and Consoles

Using Environmental Setup section of the documentation, look for step 2. The template for the .env file
is shown. You may copy the text, but it must be updated with your information.

Click on the copy button

MY _ACCOUNT ID= TESTNET ACCOUNT ID (@.8.x)
MY _PRIVATE KEY= TESTNET PRIVATE KEY (302e...)



about:blank

Go back to the Hedera testnet account ID and private key from your Hedera portal profile and enter
them in the MY_ACCOUNT _ID and MY_PRIVATE KEY fields.

HederabxamplesAPl = .env

Project = &
* [y HederaExamplesAPI MY_ACCOUNT_ID= TESTNET ACCOUNT ID (8.08.x)

¢ .gradle MY_PRIVATE_KEY= TESTNET PRIVATE KEY (3928...}'
> idea

» gradle

= 0o — build.gradle (HederaExamplesAPl) = .env

W Project

~ Src
» g main
» g test

ENY
build.gradle

gradlew

gradlew.bat
settings.gradle
External Libraries

» Yy Scratches and Consoles

W

Use the data in your Testnet account to complete the .env file. This data is saved in the accounts.txt file
in your hedera training directory.

For line “MY_ACCOUNT _ID”, enter your Testnet account ID to the right of the equals, =.

For the line MY_PRIVATE_KEY, enter your Testnet private key to the right of the equals, =.

_| accounts.txt - Notepad - O X
File Edit Format View Help
{
"operator": {
[ "accountId": "e.0.2084028",
"publickey" 1 "302a300506032b6570032100d32d7e55de28c69527e2a7d145b717dT073216214499801b%eA2a3cchamalss7™,
[ TprivateKey": "302c020100300506032b657004220420b7049e4530795dT7a79¢e713c0583dboaleacac18de68df719TF1b8%anc658bc3”
})
"network™: {
"@.testnet.hedera.com:50211": "@.0.3",
"1.testnet.hedera.com:56211": "0.80.4",
"2.testnet.hedera.com:560211": "0.0.5",
"3.testnet.hedera.com:50211": "@.@.6"
)l
¥

Ln 12, Col 6 100%  Windows (CRLF) UTF-8




IntelliJ Step 8.
Your .env file will resemble the example below

build.gradle (HederaTokenService) = .env
MY_ACCOUNT_ID=0.0.2084028
MY_PRIVATE_KEY=302e020100300506032b657004220420b7049e4530795df7a79e7f3c0583db0alb4c4c18des8df719ff1b8%abco58be3

Save the project and close the build. gradle and the .env files. One way to close the file is to click the X
on the file tabs.

= .emr| |

MY _Al
MY _Pi

You will be creating Java classes in src/main folder.

Expand the projects src/main folder.

HederaExamplesAPI SFC

Project =« BT = 0 —
u HederaBxamplesAPl C:\Usersjirm'|deaProjects\ HederaExamplesAF
’ .gradle

> Jidea

’ gradle

W Project
¢

S I

# g main

> L test
ENY
build.gradle

gradlew

gradlew.bat
settings.gradle
# |l External Libraries

# Ygy Scratches and Consoles



Save the .env file and the data to your herderaTraining folder.

A sample of the .env file and its contents is shown below. The .env files are also in the GitHub reposities.
M < | C\hederaTraining -

<« v > ThisPC > Windows (C:) °| hederaTraining v O O Search hederaTraining

hederaTraining [ Name Date modified Type Size
Hyperiedgerfab 10/1/2021 3:40 PM ENV File 1K8
1M accounts.txt 9/7/2021 2:50 PM Text Document 1KB

| *C:\hederaTraining\.env - Notepad++

File Edit Search View Encoding Language Settings Tools Macro Run Plugins Window ?

HHBR LA 4 kP dh 22 BEEIS1EIEDRAa® @ ENFE

Blew|
T MY ACCOUNT ID-0.0.2084028
2 MY_PRIVATE KEY-302e020100300506032b657004220420b7049e4530795df7a7%7£3c0583db0al04c4c18de68df719EF1b89a0c658be3

You may copy the .env file from your Intelli) project to the herderaTraining folder.

m File Edit View MNavigate Code Refactor Build Run

HederabxamplesAPl = .env

T Project «
g ~ [y HederaExamplesAPl C
L ? .gradle
? .idea
> build
b gradle
~ SrC
v g main
h Java
& HederaExamples
FESQUrCes
R
= .env
o Mew >
ATt = Cirl+X
= g =] Copy Ctrl+C
settir opy Path/Reference...
> Il External [ Paste Ctrl+V
7 "o seratche  Fing ysages Alt+F7

Analyze >
Refactor >



You may copy-paste in the .env files and build.gradle files from the GitHub repositories. Paste these files
at the project level as shown in the image.

Project ~ QI T & - buil
~ 1. HederaExarnlac | lcorc o enDiniante e el e
> .gradle 1= ’
3 idea Add Framework Support...
> Do gradle o< Cut Ctrl+X
v src B Copy Ctrl+C
¥ UL maig B
Ctrl+V
="  Find Usages Alt+F7
T Tetest  Findin Files.. Ctrl+ Shift+F
2 Replace in Files... Ctrl+Shift+R
w=Te Analyze ’

Click OK to paste the file

B Copy X

Copy file CAUsers\jim\ldeaProjects\TransferNFT\.env

Mew narme: | .enl.r{

Te directory: | Ch\Users\jim\ldeaProjects\Hederabxamples hd

Use Ctrl+5pace for path completion

? Open in editor “ Cancel




The .env and build.gradle files must appear as show below in the image.

HederabExamples
b .gradle
Jdea
gradle
SrC
main
Java
resources
test
java

de=[ECOLUTCEL

ENV
build.gradle

gradlew

gradlew.bat
img.png
settings.gradle
Il External Libraries

Scratches and Consoles

Proceed to the exercises. The next step, step 9 will be completed in the exercises themselves.

End Environmental Setup



Itelli) Step 9

Project configurations may need to be entered, or updated.
If so, validate them, if not configure using the steps below.

Edit the project configurations

Click Run -> Edit Configurations

m File Edit Yiew Mavigate Code Refactor Buil

HederaExamplesAPI

W Project

W

WOW W W

SrC - main

Project -

= HederaExamplesAPl C:\sers'jir

.gradle
Jddea
build
gradle
src

g main

e Java
C’HederaEuampIﬁ
FEsOUrCes

> [y test

= .env

build.gradle

java

ols VC5 Window Help HederaExamplesAP

1 'HederaExamples' Shift+F10

Shift+F9

&' HederaExan

o = #F Debug 'HederaExamples'
- UL Run 'HederaExamples' with Coverage

P Run... Alt+Shift+F10
£ Debug... Alt+Shift+F9
7 Profile...

1% Attach to Process...
Edit Cenfigurations...

Ctrl+Alt+F5

Stop Ctrl+F2
Stop Background Processes... Ctrl+ Shift+F2
Show Running List

Debugging Actions >

Toggle Breakpoint >



If the Configurations are empty, follow the rest of this step, step 9. NOTE: The configurations may
already be completed and entered.

If needed, click the + sign to add configuration information.

ﬂ Run/Debug Configurations X
+

conrigurations ac Add new run configuration...
Add new... Insert

Edit configuration templates...




Follow the pattern of the HederaExamples class and application shown below

Name: < Class Name >, HederaExamples for this example

Run on: Local Machine

Under Build and Run:

Select Java 11.X (other Java versions are supported) and <Project name>.main,

HederaExamplesAPl.main for this example

In the Main Class field enter: HederaExamples

Click Apply and OK

ﬂ Run/Debug Configurations

+ —- B EH K
v Application
HederaExamples

Edit configuration templates...

?

Name: HederaExamples Store as project file

Runon: A Local machine v Manage targets...

Run configurations may be executed locally or on a target: for
example in a Docker Container or on a remote host using SSH.

Build and run Modify options ~ Alt+M
java 11 50K of 'Hederat: »  -cp HederaExamplesAPI.main A
HederaExamples

Program argume
Press Alt for field hints

Working directory: C\Users\jim\ldeaProjects\HederaExamplesAPI

Environment variables:

Separate variables with semicolon: VAR=value; VAR 1=valuel

Enable EnvFile

Substitute Environment Variables (${FOO} / ${BAR:-default} / $${ESCAPED})

Process JetBrains path macro references ($PROJECT_DIRS)
gnore missing files

Enable experimental integrations (e.g. Gradle) - may break any time

Click File -> Save All




Interactive Exercise 1, Base Hedera APl Examples

Use code in:
https://github.com/theblockchainacademy/Hedera/tree/main/Hedera 1 ExampleExercisel and
complete the following steps. Iteratively complete the exercise using files partl to part3.

vz% theblockchainacademy Ad:

env

HederaExamples.java
HederaExamples_part1.tct
HederaExamples_part2.txt

HederaExamples_part3.txt

D
B
b
B
B
[ build.gradle

Make sure you have completed steps 1 — 8, Environmental Setup.

Make sure you update the build.gradle file is updated from this GitHub repository. Use your own .env
file with your own account ID and private key. An example is included in this GitHub repository.

With all Environmental Configurations complete, right click on the java folder, click New -> Java Class

HederaExamplesAPl = src  main java

o Project - I - I
g ~ g HederabxamplesAPl C:\Users\jim'|deaProjects\HederaExamplesAP
in b gradle

» JAdea

» gradle

A &rC

3| & Java Class
¢ Kotlin Class/File

trl+X
ctlc = File

= Scratch File Ctrl+Alt+ Shift+Insert
CirleV Package
package-info.java

Alt+F7 ®
3 module-info.java

Find Usages
Find in Files... Ctrl+Shift+F


about:blank

The New Java Class dialog box will open. Enter the class name: HederaExamples, and press the Enter
key.

Mew Jlava Class

[ c HederaExampIesi ]

I |nterface

E Enum

@ Annotation

The class file opens. The class file is named HederaExamples.java

HederaExamplesAPl = src - main = java & HederaExamples

o Project - NI £ Hederakxamples,java
& * I HederaBxamplesAPl C:\Users\jim\|deaProjects\HederaExampledAP public class HederaExamples {
L > .gradle +

¥ Jidea

> gradle

src
[y main
e java
€ HederaExamples
FESOUrces
> g test
= .env
build.gradle



Validate project configurations, see Intelli) Step 9. Project configurations will resemble the image below.

g Run/Debug Configurations X
+ - EBEEMNR
v Application Name: HederaExamples Store as project file

HederaExamples
Runon: A Local machine v Manage targets...

Run configurations may be executed locally or on a target: for
example in a Docker Container or on a remote host using SSH.

Build and run Modify options v Alt+M
java 11 SDK of 'Hederab: » | -cp HederaExamplesAPI.main A
HederaExamples

Press Alt for field hints

Working directory: C\Users\Jim\ldeaProjects\HederaExamplesAPI

Environment variables:
Separate variables with semicolon: VAR=value; VAR 1=value1
Enable EnvFile

Substitute Environment Variables (${FO0} / ${BAR:-default} / $${ESCAPED})

Process JetBrains path macro references ($SPROJECT_DIRS)

gnore missing files

Enable experimental integrations (e.g. Gradle) - may break any time
Edit configuration templates...

Enter the source code below into the HederaExamples class file. This is file HederaExamples in GitHub:
HederaExamples partl.txt,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera 1 ExampleExercisel/HederaExa

mples partl.txt

import com.hedera.hashgraph.sdk.*;
import io.github.cdimascio.dotenv.Dotenv;

import java.util.concurrent.TimeoutException;
public class HederaExamples ({

public static void main(String[] args) throws TimeoutException,
PrecheckStatusException, ReceiptStatusException {

//Grab your Hedera testnet account ID and private key
AccountId myAccountId =
AccountId. fromString(Dotenv.load() .get ("MY ACCOUNT ID"));
PrivateKey myPrivateKey =
PrivateKey.fromString(Dotenv.load() .get ("MY PRIVATE KEY"));

//Create your Hedera testnet client


about:blank
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Client client = Client. forTestnet();
client.setOperator (myAccountId, myPrivateKey) ;

HederaExamplesAPl = src -~ main = java € HederaExamples  m main

b Project = B = = & — & Hederabxamplesjava
£ Iz HederaExamplesAPI import com.hedera.hashgraph.sdk.*;
- ? -gradle import ic.github.cdimascio.dotenv.Dotenv;
> I .idea
’ build import java.util.concurrent.TimeoutException;
> I gradle
U »  public class HederaExamples {
main
v [ java
e > public static void main(Stringl[] args) throws TimeoutException {
resources
> g test Grab your Hedera testnet account ID and private Key
= .env AccountId myAccountId = AccountId.fromString(Dotenv.lead().get("MY_ACCOUNT_ID"));
build.gradle PrivateKey myPrivateKey = PrivateKey.fromString(Dotenv.lood().get("MY_PRIVATE_KEY"));
gradlew
= gradlew.bat reate \ Hedera testnet client
Sem"qs‘gra_dle Client client = Client.forTestnet();
7 Il Bxternal Libraries lient.setOperator(myAccountId, myPrivateKey);
> Scratches and Consoles client. P ¥ o Y2i

Append the source code below to the class. The source below is in the GitHub file:

HederaExamples partl.txt,

https://github.com/theblockchainacademy/Hedera/blob/main/Hedera_1 ExampleExercisel/HederaExa
mples_partl.txt

// Code to generate a new key pair
PrivateKey newAccountPrivateKey = PrivateKey.generate();

PublicKey newAccountPublicKey = newAccountPrivateKey.getPublicKey() ;

//Code to create new account and assign the public key
TransactionResponse newAccount = new AccountCreateTransaction ()
.setKey (newAccountPublicKey)
.setInitialBalance ( Hbar.fromTinybars (1000))
.execute (client) ;
// Get the new account ID

AccountId newAccountId = newAccount.getReceipt (client) .accountId;

System.out.println ("The new account ID is: " +newAccountId);


about:blank

HederaExamplesAPl | stc - main | java = (& HederaExamples i main

g Project ¥ B I T @ — @ Hederabxamples.java
E ~ 175 HederaExamplesAPl C:\ Users\jim\ | deaProjects\ HederaEvamplesiP import com.hedera.hashgraph.sdk.*;
= > gradle import ie.github.cdimascio.dotenv.Dotenv;
> [ idea
: Dl import java.util.concurrent.TimeoutException;
gradle
~ src s
- _ > public class HederaExamples {
% main
[ java
€ Hederabxamples > public static void main(String[] args) throws TimeoutException, PrecheckStatusException, ReceiptStatusException {
= resources
> Bgtest testn nt ID ]
= env AccountId myAccountId = AccountId.fromString(Dotenv.leod().get("MY_ACCOUNT_ID"));
build.gradle PrivateKey myPrivateKey = PrivateKey.fromString(Dotenv.load().get("MY_PRIVATE_KEY"));
gradlew
2 gradiew.bat

settings.gradle
> 1l External Libraries

> U Scratches and Consoles

Click Run -> Run ‘Hedera Examples’

m File Edit View Mavigate Code Refactor EuildIﬂoIs VC5 Window Help HederaExamplesAP

HederaExamplesAPl = src  main = java

Project -

* g HederabxamplesAPl C Uzer
Jgradle

W Project |

Jddea
build
gradle

£ W W W

5rc

[ main

"" java

/Create your Hedera testnet client
Client client = Client.forTestnet();
client.setOperator(myAccountId, myPrivateKey);

e to erate a new #
PrivateKey newAccountPrivateKey = PrivateKey.generate();
PublicKey newAccountPublicKey = newAccountPrivateKey.getPublicKey();

/Code to create new gccount 1 Key
TransactionResponse newAccount = new AccountCreateTransaction()
.setKey(newAccountPublicKey)
.setInitialBalance( Hbar.fromTinybars(1000))
.execute(client);

n the

/ Get the new gccount ID

AccountId newAccountId = newAccount.getReceipt(client).accountld;

System.out.println("The new account ID is: " +newAccountId);

B HederaFxa Run derabxamples’ Shift+F10
o = # Debug 'HederaFxamples' Shift+F9
=~ N} Run 'HederaExamples' with Coverage

\jim'ldeaProjects\H C} Run 'HederaExamples' with "Windows Async Profiler' > ;

P Run... Alt+Shift+F10

# Debug... Alt+Shift+F9

7 Profile... |

f’,‘. Attach to Process... Ctrl+Alt+F5
Edit Configurations... |
Manage Targets...



The Run Console will open. Disregard the [hedera-sdk] WARN
com.hedera.hashgraph.sdk.TransactionReceiptQuery warnings. These are warnings
not errors

Look for the new account ID output.

You should see the sharded account ID. Your account ID results will be different.
4:24:22 PM: Executing task ':HederaExamples.main()'...

> Task :compilelava
> Task :processResources NO-SOURCE
> Task :classes

> Task :HederaExamples.main()
[hedera-sdk-7] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.0.4 in 250 ms after failure during attempt #1: OK
[hedera-sdk-3] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.0.4 in 580 ms after failure during attempt #2: OK
[hed Skt WARN cophad Rashoraph sk T tioRReceiptQuenry—Retrying-hode 0.0.4 in 1008 ms after failure during attempt #3: OK
The new account ID is: 0.0.2700579

Deprecated Gradle features were used in this buvild, making it incompatible with Gradle 8.0.

You can use '--warning-mode all' to show the individual deprecation warnings and determine if they come from your own scripts or plugins.

See https://docs.gradle.org/7.1/userquide/command_line_interface.html#sec:command_line_warnings

BUILD SUCCESSFUL in 4s
2 actionable tasks: 2 executed
4:24:27 PM: Task execution finished ':HederaExamples.main()'.

Append the solution source code below to the class. The source below is in the GitHub file:
HederaExamples part2.txt,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera_1_ExampleExercisel/HederaExa
mples_part2.txt

Add the source code below is the same Java class.

//Check the new account's balance

AccountBalance accountBalance = new AccountBalanceQuery()
.setAccountld(newAccountld)

.execute(client);

System.out.printIn("The new account balance is: " +accountBalance.hbars);


about:blank

e HederaExamples,java

import com.hedera.hashgraph.sdk.*;
ilport io.github.cdimascio.dotenv.Dotenv;

import java.util.concurrent.TimeoutException;

> public class HederaExamples {

> public static void main(String[] args) throws TimeoutException, PrecheckStatusException, ReceiptStatusException {

b your Hedera te int ID and private key

AccountId myAccountId = AccountId.fromString(Dotenv.load().get("MY_ACCOUNT_ID"));
PrivateKey myPrivateKey = PrivateKey.fromString(Dotenv.load().get("MY_PRIVATE_KEY"));

t acc

/Create

Client client =
client.setOperator(myAccountId, myPrivateKey);

// Code to g te a new key pair

PrivateKey newAccountPrivateKey = PrivateKey.generate();

PublicKey newAccountPublicKey = newAccountPrivateKey.getPublicKey();

e to ne key

TransactionResponse newAccount = new AccountCreateTransaction()
.setKey(newAccountPublicKey)
.setInitialBalance( Hbar.fromTinybars(1000))
.execute(client);

/ Get the new @ nt 10

AccountId newAccountId = newAccount.getReceipt(client).accountId;

System.out.println("The new account ID is: " +newAccountId);

k the new account's ba

AccountBalance accountBalance = new AccountBalanceQuery()
.setAccountId(newAccountId)
.execute(client);

System.ovt.println("The new account balance is: " +accountBalance.hbars);

Append the solution source code below to the class. The source below is in the GitHub file:
HederaExamples part3.txt,

https://github.com/theblockchainacademy/Hedera/blob/main/Hedera_1_ExampleExercisel/HederaExa
mples_part3.txt

The whole application source code is below, also on GitHub repository file: HederaExamples.java,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera_1_ExampleExercisel/HederaExa

mples.java

import com.hedera.hashgraph.sdk.*;
import io.github.cdimascio.dotenv.Dotenv;

import java

.util.concurrent.TimeoutException;

public class HederaExamples ({


about:blank
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public static void main(String[] args) throws TimeoutException,
PrecheckStatusException, ReceiptStatusException {

//Grab your Hedera testnet account ID and private key
AccountId myAccountId =
AccountId. fromString(Dotenv.load() .get ("MY ACCOUNT ID"));
PrivateKey myPrivateKey =
PrivateKey.fromString(Dotenv.load() .get ("MY PRIVATE KEY"));

//Create your Hedera testnet client
Client client = Client. forTestnet();
client.setOperator (myAccountId, myPrivateKey) ;

// Code to generate a new key pair
PrivateKey newAccountPrivateKey = PrivateKey.generate();
PublicKey newAccountPublicKey = newAccountPrivateKey.getPublicKey () ;

//Code to create new account and assign the public key
TransactionResponse newAccount = new AccountCreateTransaction ()
.setKey (newAccountPublicKey)
.setInitialBalance( Hbar.fromTinybars (1000))
.execute (client);

// Get the new account ID
AccountId newAccountId = newAccount.getReceipt (client) .accountId;

System.out.println ("The new account ID is: " +newAccountId);

//Check the new account's balance
AccountBalance accountBalance = new AccountBalanceQuery ()
.setAccountId(newAccountId)
.execute (client);
System.out.println ("The new account balance is:
+accountBalance.hbars) ;



Click Run -> Run ‘Hedera Examples’

m Eile Edit View MNavigate Code Refactor Build lQIGN Tools VC5 Window Help HederaExamplesAP

HederabxamplesAFPl = src © main = java &' HederaExani Run 'Hederabxamples’ Shift+F10
— & Debug Hederakxamples’ shift+FY

i Project « D = : i .

Z U} Run 'HederaFxamples' with Coverage

: ¥ Wa HederabamplesAPl C:\Users\jimildeaProjects\H (% Run 'HederaExamples' with "Windows Async Profiler’ >
> .gradle

.g P Run.. Alt+Shift+F10

? idea )
5 build E=3 DEbl._Ig... Alt+5hift+F9
5 gradle 7 Profile...
" crc £% Attach to Process... Ctrl+Alt+F5

v g main Edit Configurations...

W java Manage Targets...

The Run Console will open. Disregard the [hedera-sdk-7] WARN
com.hedera.hashgraph.sdk.TransactionReceiptQuery warnings. These are warnings and not errors.

Look for the new account ID output, and the account balance
You should see the sharded account ID, and the account balance.

The fonts for hbars, ki, cannot be rendered in the console. It returns “t?” for hbars.

4:39:27 PM: Executing task ':HederaExamples.main()'...

> Task :compileJava UP-TO-DATE
> Task :processResources NO-SOURCE
> Task :classes UP-TO-DATE

> Task :HederaExamples.main()
[hedera-sdk-7] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 08.8.6 in 250 ms after failure during attempt #1: OK
[hedera-sdk-2] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.8.6 in 580 ms after failure during attempt #2: OK
hedera-sdk-6] WARN com.hedera.hasharaph _TransactionReceiptQuery - Retrving node 8.0.6 in 10008 ms after failure during attempt #3: OK
The new account ID is: 0.0.2788983
The new account balance is: 1880 t? <—

=

Deprecated Gradle features were used in this bwild, making it incompatible with Gradle 8.8.
You can use '--warning-mede all' to show the individual deprecation warnings and determine if they come from your own scripts or plugins.

See https://docs.gradle.org/7.1/userquide/command_line_interface.html#sec:command_line_warnings

BUILD SUCCESSFUL in 5s
2 actionable tasks: 1 executed, 1 up-to-date
4:39:33 PM: Task execution finished ':HederaExamples.main()'.



Interactive Exercise 2

Describe how Hedera Hashgraph Consensus resolves issues that other blockchains struggle with.

1. Describe: Proof-of-Stake consensus.
2. Describe Asynchronous Byzantine Fault Tolerance. What is the significance of the mathematical
proof?

3. How about decentralization?



Interactive Exercise 3

How does Hedera Hashgraph Governance Model benefit users.

The Governing Council advices on what?

The Governing Council comes from a representative set of industries.
Do they make decisions?

What else?



Interactive Exercise 4

Before completing this exercise, watch the steps for this interactive exercise included in the video
lessons.

Navigate to https://hedera.com/buying-guide and https://docs.hedera.com/guides/mainnet/mainnet-
access

Select a wallet and follow the steps for mainnet account creation.

Atomic
O\ Wallet

Mainnet Access

You will need a Hedera mainnet account to interact with and pay for any of the network services
(cryptocurrency, consensus, tokens, files and smart contracts). Your Hedera account is what holds a
balance of hbar to be used for transfers to other accounts or payments for network services.

Create free mainnet accounts by visiting any of these wallet providers:

Wallet Private Key Viewable SDK-compatible Passphrase
Atomic

Coinomi

Exodus (Desktop)

Guarda

Hashpack

Xact

Wallawallet

After you receive your account ID and private keys, you can create additional mainnet accounts using
the SDKs. When using the SDKs to build your Hedera client, select client.forMainnet() . A
mainnet node will be picked at random to submit the transaction to.


about:blank

Interactive Exercise 5

Mirrornet Queries

1. Before completing Start with base MirrorNet URL
https://mainnet-public.mirrornode.hedera.com
2. Append text to URL /api/vl

https://mainnet-public.mirrornode.hedera.com/api/vl

3. Add text for queries: transactions, accounts, tokens etc
https://mainnet-public.mirrornode.hedera.com/api/vl/transactions
Mirrornet for Mainnet URLs:
https://mainnet-public.mirrornode.hedera.com/api/vl/transactions

https://mainnet-public.mirrornode.hedera.com/api/vl/accounts

Mirrornet for Testnet URLs
https://testnet.mirrornode.hedera.com/api/v1/transactions/?account.id=0.0.29589707
https://testnet.mirrornode.hedera.com/api/vl/accounts?account.id=0.0.29589707

https://testnet.mirrornode.hedera.com/api/v1/tokens?account.id=0.0.29589707

Run queries:
https://mainnet-public.mirrornode.hedera.com/api/v1l/transactions
https://mainnet-public.mirrornode.hedera.com/api/vl/accounts
Add an ascending and descending filter.
https://testnet.mirrornode.hedera.com/api/vl/transactions
https://testnet.mirrornode.hedera.com/api/vl/accounts

https://testnet.mirrornode.hedera.com/api/v1/tokens

Run the queries below for your testnet account id
https://testnet.mirrornode.hedera.com/api/v1/transactions
https://testnet.mirrornode.hedera.com/api/vl/accounts

https://testnet.mirrornode.hedera.com/api/vl/tokens


about:blank
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Interactive Exercise 6

Before completing this exercise, watch the steps for this interactive exercise included in the video
lessons.

Use code in:
https://github.com/theblockchainacademy/Hedera/tree/main/Hedera_8_TransactionSetupExercise8
and complete the exercise using the code in the repository.

<4 theblockchainacademy

4 .env

[ TransactionSetupjava

[ build.gradle

Start Itelli) and click New Project. Name the new project HederaTokenServiceSetup.
Follow the Environmental Configurations, IntelliJ Steps 1 — 8, from the beginning of this document.

Make sure you update the build.gradle file is updated from this GitHub repository. Use your own .env
file with your own account ID and private key. An example is included in this GitHub repository.

File Edit View Mavigate Code Refactor Build Run Tools VC5 Window Help

HederaTokenService = .env

Py
ko
1L
e
|

Project « build.gradle (HederaTokenService) = env

& HederaTokenService MY_ACCOUNT_ID=0.0.2084028
' -gradle MY _PRIVATE_KEY=302e020100300506
idea
build
gradle

W Project

Src

test
build.gradle
build.gradle.bak

gradlew

gradlew.bat
hedera.jpg
settings.gradle
External Libraries
Scratches and Consoles



Right click on folder src/main/java. Click New -> Java Class.

Enter TransactionSetup

c

I

E

@ Annotation

Mew lava Class

Transaction Setup-|

Interface

Enum

Enter code from the repository:
https://github.com/theblockchainacademy/Hedera/tree/main/Hedera_8_ TransactionSetupExercise8

@ TransactionSetu pjava

import com.hedera.hashgraph.sdk.*;
import io.github.cdimascio.dotenv.Dotenv;

import java.nio.charset.StandardCharsets;
import java.util.=*;
import java.util.concurrent.TimeoutException;

public final class TransactionSetup {

ee .env.sample  in the repositery root for how to specify these values

// or set environment variaobles with the same names
private static final AccountId OPERATOR_ID = AccountId.fromString(Objects.requireNonNull(Dotenv.load().get("MY_ACCOUNT_ID")));
private static final PrivateKey OPERATOR_KEY = PrivateKey.fromString(Objects.requireNonNull(Dotenv.load().get("MY_PRIVATE_KEY")));

/ HEDERA_NETWORK defoults to testnet if not specified in dotenv

private static final String HEDERA_NETWORK = Dotenv.load().get( envMame "HEDERA_METWORK", defValue: "testnet");
private TransactionSetup() {
}

public static void main(String[] args) throws TimeoutException, PrecheckStatusException, ReceiptStatusException {
Client client = Client.forName (HEDERA_NETWORK);

'/ Defoults the operotor account ID and key such thot all generated transoctions will be paid for

by this account and be signed by this key

client.setOperator (OPERATOR_ID, OPERATOR_KEY);

Create three accounts, Alice and Bob. Alice will be the tr

Fees only

pply in actions not involving the treasury,

PrivateKey aliceKey = PrivateKey.generate();

AccountId aliceld = new AccountCreateTransaction()
.setInitialBalance(new Hbar( amount 10)) AccountCreateTransaction
.setKey(aliceKey)

.freezeWith(client)
.sign(aliceKey)

.execute(client) TransactionResponse
.getReceipt(client) TransactionReceipt
.accountId;




& Transa ctionSetup.java

41 PrivateKey bobKey = PrivateKey.generate();

42 AccountId bobId = new AccountCreateTransaction()

43 .setInitialBalance(new Hbar( amount 18)) AccountCreateTransaction
44, .setKey(bobKey)

45 .freezeWith(client)

46 .sign(bobKey)

47 .execute(client) TransactionResponse

48 .getReceipt(client) TransacticnReceipt

49 .accountId;

51 System.ovt.println("Alice account ID: " + aliceld);

52 System.out.println("Bob account ID: " + bobId);

54 TokenId tokenId = new TokenCreateTransaction()

59 .setTokenName("TBA NFT") TokenCreateTransaction

56 .setTokenSymbol("TBA-NFT")

57 .setTokenType(TokenType.NON_FUNGIBLE_UNIQUE)
.setAdminKey(aliceKey) // so that we can delete later on
.setSupplyKey(aliceKey) // so thot we con mint later on
if: .setTreasuryAccountId(aliceld)

41 .freezeWith(client)

42 .sign(aliceKey)

.execute(client) TransactionResponse

b4 .getReceipt(client) TransactionReceipt

.tokenId;
57 System.out.println("NFT Token ID: " + tokenId);
// We must associaote the token with Bob and Charlie before they con trade in it.

71 new TokenAssociateTransaction()

72 .setAccountId(bobId)

73 .setTokenIds(Collections.singletonlList(tokenId))
74 .freezeWith(client)

75 .sign(bobKey)

.execute(client)

.getReceipt(client);




& TransactionSetu pjava
7 AccountBalance accountBalance = new AccountBalanceQuery() //One method to get occount bolance
.setAccountId(aliceld)
1 .execute(client);

System.out.println("The Alice account balance before is: " +accountBalance);

AccountBalance accountBobBalance = new AccountBalanceQuery() //One method to get occount balance
.sethAccountId(bobId)
.execute(client);

System.out.println("The Bob account balance before is: " +accountBobBalance);

1 //Transaction record vsed to ovtput tronsaoction details

2 //8end the lost part of the NFT to the receiver. Charge HBor fees and get a record
TransactionRecord recordl = new TransferTransaction()
4 //.addNftTransfer(new NftId(tokenId, serials.size()), aliceId, bobId)
.addHbarTransfer(bobId, Hbar.from(-4))
: .addHbarTransfer(aliceId, Hbar.from(4))
7 .freezeWith(client)
.sign(bobKey)
.sign(aliceKey)
106 .execute(client)
101 .getRecord(client);

183 System.out.println("Transaction record: tokenID: {[TokenNftTransfer{sender, receiver, serialll} " + recordl.tokenNftTransfers);
185 Hbar aliceHbar2 = new AccountBalanceQuery()
106 .setAccountId(aliceId)

1 .execute(client)
108 .hbars;

111 Hbar bobHbar2 = new AccountBalanceQuery()
112 .setAccountId(bobId)

113 .execute(client)

114 .hbars;

116 System.out.println("Alices's HBar balance after token transfer to Bob: " + aliceHbarZ)ﬂ
11 System.out.println("Bob's HBar balance after token transfer from Alice: " + bobHbar2);

119 client.close();

Click Run -> Run ‘TransactionSetup’

Tools VCS Window Help TransferNFT - Transa

Run "TransactionSetup’ Shift+F10

Debug ‘TransactionSetup’ Shift+F9

« U} Run TransactionSetup' with Coverage
(s Run 'TransactionSetup' with 'Windows Async Profiler' >



The results will appear close to the output below:
9:36:56 AM: Executing task ':TransactionSetup.main()'...
> Task :compileJava UP-TO-DATE
> Task :processResources NO-SOURCE

> Task :classes UP-TO-DATE

> Task :TransactionSetup.main()

[main] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node ©.0.7 in 250 ms after failure during attempt #1: OK
[main] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node ©.8.7 in 580 ms after failure during attempt #2: 0K
[main] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.8.5 in 256 ms after failure during attempt #1: 0K
[main] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.8.5 in 580 ms after failure during attempt #2: 0K

Alice account ID: 8.0.38873300

Bob account ID: 0.08.30873301

[main] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node ©.6.
[main] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node ©.8.
NFT Token ID: 0.0.30873302

[main] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.8.6 in 250 ms after failure during attempt #1: OK
[main] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.8.6 in 580 ms after failure during attempt #2: OK
The Alice account balance before is: AccountBalance{hbars=10 ?, tokens={0.0.30873362=0}}

The Bob account balance before is: AccountBalance{hbars=16 ?, tokens={6.0.30873302=0}}

[main] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.8.4 in 250 ms after failure during attempt #1: 0K
[main] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node ©.0.4 in 500 ms after failure during attempt #2: OK
Transaction record: tokenID: {[TokenNftTransfer{sender, receiver, seriall}l} {}

Alices's HBar balance after token transfer to Bob: 14 ?

Bob's HBar balance after token transfer from Alice: 6 ?

I

in 250 ms after failure during attempt #1: OK
in 560 ms after failure during attempt #2: OK

[

Deprecated Gradle features were vsed in this bvild, making it incompatible with Gradle 8.0.

You can use '--warning-mode all' to show the individuval deprecation warnings and determine if they come from your own scripts or plugins.

See https://docs.gradle.org/7.1/userguide/command_line_interface.html#sec:command_line_warnings

BUILD SUCCESSFUL in 8s
2 actionable tasks: 1 executed, 1 up-to-date
9:37:05 AM: Task executlon finished ':TransactionSetup.main()'.



Interactive Exercise 7

Consensus establishes what for the network?

All nodes agree and ...
Double spending is prevented.

What else?



Interactive Exercise 8

Hedera Token Service

Use code in:
https://github.com/theblockchainacademy/Hedera/tree/main/Hedera_2_TokenServiceExercise2 and
complete the following steps. Iteratively complete the exercise using files partl to part3.

<4 theblockchainacademy Update

.env
HederaTokenService.java

HederaTokenServicePart1.txct
HederaTokenServicePart2.txt
HederaTokenServicePart3.tet

build.gradle

0D DD DODDOEDEPDO

hashgraph-javascript-token.zip

Start Itelli) and click New Project. Name the new project HederaTokenService.
Follow the Environmental Configurations, Intelli) Steps 1 — 8, from the beginning of this document.

Make sure you update the build.gradle file is updated from this GitHub repository. Use your own .env
file with your own account ID and private key. An example is included in this GitHub repository.

File Edit View MNavigate Code Refactor Build Run Joels VC5 Window Help

HederaTokenService = .env

4]
3
Il
3k

Project « o — build.gradle (HederaTokenService) = .env

= HederaTokenService MY_ACCOUNT_ID=0.0.2084028
-gradle MY_PRIVATE_KEY=302e020100300506
Jddea
build
gradle

W Project

SIC
main
test

= .env
build.gradle

= build.gradle.bak
gradlew

= gradlew.bat
hedera.jpg
settings.gradle

External Libraries

Scratches and Consoles



Right click on folder src/main/java. Click New -> Java Class.

m File Edit Yiew Mavigate Code Refactor Build Run Tools VC: Window Help HederaToken

HederaTokenService = src = main java
o Project « T - B
E ~ g HederaTokenService C:'\lUsers\jim'|deaProjects\HederaTokenService
in > .gradle
> Jddea
> build
> gradle

Erc

Java Class
¢ Kotlin Class/File

Ctrl+X

Ctrlec = File
= Seratch File Chrl+Alt+
e Packane

Name the new class HederaTokenService and press the enter key.

Mew lava Class

£ HederaTokenServi cel

I |nterface
E Enum

@ Annotation

The code stubs will be created.

£ HederaTokenService,java

public class HederaTokenService {
e



Validate project configurations, see Intelli) step 9. Project configurations will resemble the image below.

a Run/Debug Configurations
+ - B AR

v Application
HederaTokenService

Name:

Run on:

Edit configuration templates...

?

java 11 SDK

Working directory:

X
HederaTokenService Store as project file

# Local machine - Manage targets...

Run configurations may be executed locally or on a target: for
example in a Docker Container or on a remote host using SSH.

Modify options ~ Alt+M

Build and run

p HederaTokenService.main

of 'HederaToke

HederaTokenService

am argume

Press Alt for field hints

C\Users\jim\ldeaProjects\HederaTokenService

Environment variables:

Separate variables with semicolon: VAR=value; VAR1=valuel

Enable EnvFile

Substitute Environment Variables (${FOOQ} / ${BAR:-default} / $${ESCAPED})
Process JetBrains path macro references ($PROJECT_DIRS)

Ignore missing files
Enable experimental integrations (e.q. Gradle) - may break any time!

Cancel Apply




Enter Part 1 of the code below, use GitHub file: HederaTokenServicePartl.txt,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera_2_ TokenServiceExercise2/Heder
aTokenServicePartl.txt

import com.hedera.hashgraph.sdk.*;
import io.github.cdimascio.dotenv.Dotenv;
import java.util.Collections;

import java.util.concurrent.TimeoutException;

public final class HederaTokenService ({

//private static final AccountId OPERATOR ID =
AccountId.fromString (Objects.requireNonNull (Dotenv.load () .get ("OPERATO
R ID")));

//private static final AccountId OPERATOR ID =
AccountId.fromString ("0.0.2084028");

// HEDERA NETWORK defaults to testnet if not specified in dotenv

private static final AccountId OPERATOR ID =
AccountId.fromString (Dotenv.load() .get ("MY ACCOUNT ID"));

private static final PrivateKey OPERATOR KEY =
PrivateKey.fromString (Dotenv.load () .get ("MY PRIVATE KEY"));

private static final String HEDERA NETWORK =
Dotenv.load() .get ("HEDERA NETWORK", "testnet");

private HederaTokenService () {

}

public static void main (String[] args) throws TimeoutException,
PrecheckStatusException, ReceiptStatusException {
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Run only Intelli) Step 6, Refresh Gradle, from Exercise 1.

Gradle

»
>

4+

w = Tk 4 F

HederaTokenService

& lasks

il Dependencies

The application should appear as below.

& Hed eraTokenServicejava

import com.hedera.hashgraph.sdk.*;
import io.github.cdimascio.dotenv.Dotenv;

import java.util.Collections;
import java.util.concurrent.TimeoutException;

public final class HederaTokenService {

/ see ".env.sample’ in the repository root for how to specify these values

ples with the same names

//private
//private static final AccountId OPERATOR_ ccountId. fromString("0.0.2084028");
// HEDERA_NETWORK defoults to testnet if not specified in dotenv

private static final AccoumtId OPERATOR_ID = Accountld.fromString(Dotenv.load().get("MY_ACCOUNT_ID"));
private static final PrivateKey OPERATOR_KEY = PrivateKey.fromString(Dotenv.load().get("MY_PRIVATE_KEY"));

private static final String HEDERA_NETWORK = Dotenv.load().get( envMame "HEDERA_NETWORK", defValus "testnet");

=

private HederaTokenService() {

3

nal AccountId OPERATOR_ID = AccountId.fromString(0bjects.requireNenNull({Dotenv.load().get("(
ID A

public static void main(String[] args) throws TimeoutException, PrecheckStatusException, ReceiptStatusException {



Run the Application

Click Run -> Run ‘HederaTokenService’

m File Edit View MNavigate Code Refactor Build @GM Tools VCS5 Window Help HederaToken5ervice - H

HederaTokenService  src - main = java € HederaTo Run "HederaTokenService' Shift+F10
Shift+F9

Ui Run 'HederaTokenService' with Coverage '
~ g HederaTokenService C Users\jim'deaProjects G

kY .

) Debug 'HederaTokenService'
Project -

N Project |

Run 'HederaTokenService' with 'Windows Async Profiler'  »

The results will appears as shown below.

3:51:17 PM: Executing task ':HederaTokenService.main()'...

> Task :compiledava UP-TO-DATE

> Task :processResources NO-SOURCE

> Task :classes UP-TO-DATE

> Task :HederaTokenService.main()

Deprecated Gradle features were wused in this build, making it incompatible with Gradle 8.08.

You can use '--warning-mode all' to show the individual deprecation warnings and determine if they come from your own scripts or plugins.

See https://docs.gradle.orq/7.1/userguide/command line_interface.html#sec:command line warnings

BUILD SUCCESSFUL in 596ms
2 actionable tasks: 1 executed, 1 up-to-date
3:51:18 PM: Task execution finished ':HederaTokenService.main()'.



Build a client to interact with Hedera Nodes: https://docs.hedera.com/guides/docs/sdks/client

e Client.forTestnet()
e Client.forMainnet()
o Client.forName(HEDERA_NETWORK)

Use the Hedera Token Service to create a fungible token, and accounts for trading.

e Generate a key for Alice

e (Create an account for Alice

e Generate a key for Bob

e Create an account for Bob.

e Output the results to the console.

Refer to the solution in GitHub: HederaTokenServicePart2.txt,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera_2_TokenServiceExercise2/Heder
aTokenServicePart2.txt

The results will resemble the results shown below
2:23:01 PM: Executing task ':HederaTokenService.main()'...

> Task :compilelava
> Task :processResources NO-SOURCE
> Task :classes

> Task :HederaTokenService.main()

hedera-sdk-7] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.5 in 250 ms after failure during attempt #1: OK
hedera-sdk-3] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.8.6 in 580 ms after failure during attempt #2: OK
hedera-sdk-6] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.8.6 in 1000 ms after failure during attempt #3: 0K
hedera-sdk-3] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.8.3 in 258 ms after failure during attempt #1: OK
ctienReceiptQuery - Retrying node ©.8.3 in 508 ms after failure during attempt #2: OK

[
[
[
[

Alice's account ID: 0.0.2773618
Bob's account ID: 0.6.2773619

Alice's Hbar balance before token transfers:

Deprecated Gradle features were used in this bwild, making it incompatible with Gradle 8.8.
You can use '--warning-mode all' to show the individval deprecation warnings and determine if they come from your own scripts or plegins.

See https://docs.gradle.ora/7.1/vserguide/command_line interface.html#fsec:command _line_warnings

BUILD SUCCESSFUL in 7s
2 actionable tasks: 2 executed
2:23:08 PM: Task execution finished ':HederaTokenService.main()}'.
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Create the Token

Reference: https://docs.hedera.com/guides/docs/sdks/tokens,
https://docs.hedera.com/guides/docs/sdks/tokens/define-a-token

Use the Hedera Token Service to create a new fungible token (FT) .

Set the token name as Example Token, and the symbol as EX.

Set Alice as the treasury account, Set the initial supply to 20.

Return the token ID, and the token type. Verify that that the token is of type fungible.
Associate Bob with the token and mint 100 additional tokens of type Example Token.
Get the balance of tokens in Alice’s and Bob’s wallet after minting and output the results.
Transfer 40 tokens of type Example Token from Alice to Bob, and charge Bob 1 HBar.

Get the token and HBar Balance for Alice and Bob after the transfer transaction and output to the
console.


about:blank

Run the Application

Click Run -> Run ‘HederaTokenService’

m File Edit View MNavigate Code Refactor Build @GM Tools VCS5 Window Help HederaToken5ervice - H

HederaTokenService  src - main = java € HederaTo Run "HederaTokenService' Shift+F10

) ¥ Debug 'HederaTokenService' Shift+F9
G Project - ) ) ;
.5 Ui Run 'HederaTokenService' with Coverage '
: 7 | n HederaTokenService £ e ymiicesfioecsy (k. Run 'HederaTokenService' with 'Windows Async Profiler’ >
" P e L
The results will appears as shown below.

Refer to the solution in GitHub: HederaTokenServicePart3.txt,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera_2_ TokenServiceExercise2/Heder
aTokenServicePart3.txt

> Task :HederaTokenService.main()

[hedera-sdk-7] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.5 in 258 ms after failure during at
[hedera-sdk-3] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.5 in 500 ms after failure during at
[hedera-sdk-6] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.4 in 250 ms after failure during at
[hedera-sdk-0] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.4 in 500 ms after failure during at
Alice's account ID: 0.0.2817465

Bob's account ID: 0.0.2817467

Alice's Hbar balance before token transfers: 10 ?

[hedera-sdk-08] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.6 in 258 ms after failure during at
[hedera-sdk-4] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.6 in 508 ms after failure during at
Token: 0.0.2817468

FUNGIBLE_COMMON

[hedera-sdk-4] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.7 in 258 ms after failure during at

[hedera-sdk-7] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.7 in 500 ms after failure during at

[hedera-sdk-2] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.7 in 1080 ms after failure during a
Minting

[hedera-sdk-2] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.3 in 258 ms after failure during at
[hedera-sdk-6] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.3 in 508 ms after failure during at
[hedera-sdk-3] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.3 in 1000 ms after failure during a

The transaction consensus status is SUCCESS

The Alice account balance before is: AccountBalance{hbars=10 ?, tokens={0.0.2817468=120}}

The Bob account balance before is: AccountBalance{hbars=10 ?, tokens={0.0.2817468=0}}

Transfer

[hedera-sdk-7] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.6 in 258 ms after failure during at
[hedera-sdk-0] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.6 in 500 ms after failure during at
The Alice account halance after is: AccountBalance{hbars=11 ?, tokens={0.0.28174468=80}}

The Bob account balance after is: AccountBalance{hbars=9 ?, tokens={0.0.2817468=40}}

Alice's Hbar balance after token: 11 ?
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Create a Non-Fungible Token (NFT)

Use code in:
https://github.com/theblockchainacademy/Hedera/tree/main/Hedera_3_NFTTokensExercise3 and
complete the following steps. Iteratively complete the exercise using files TransferNFT_1 to
TransferNFT_3.

env

TransferNFT java
TransferNFT_1.txt
TransferNFT_2.txt

TransferNFT_3.txt

[ o B i R e R i R

build.gradle

Start ItelliJ and click New Project called TransferNFT
Follow the Intelli) Steps 1 — 7, from assignment 1. Make sure the .env and build.gradle files are updated.
Eile Edit View Mavigate Code Refactor Build Run Tools

TransferNFT build.gradle

Project - D= T 0o -
[‘“" TransferMFT ]
Jgradle

I Project

Adea
gradle
Ere
main
test

)
n

Env
build.gradle

gradlew

gradlew.bat
settings.gradle
Il External Libraries

Scratches and Consoles



Right click on folder src/main/java. Click New -> Java Class.

m File Edit Wiew Mavigate Code Refactor Build Run Tools VC5 Window Help TransferMFT - build.gradle (

TransferNFT = src .~ main Java
o Project - EE' E = g - build.gradle (TransferMFT)
E ~ Mg TransferNFT C\Users\jim'ldeaProjects\ TransferMFT J/start buvild.grodle file
] > I .gradle plugins {
> Jidea id 'java'
b gradle }

src

group 'org.example’

Java Class

& Kotlin Class/File

Ctrl+X

ctrlsc = File
= Scratch File Ctrl+ Alt+ Shift+ Insert

Copy Path/Reference...

build.gradle

Name the new class TransferNFT, and press the enter key.

Mew Java Class
< TransferNFfl

I |nterface
E Enum

@ Annotation

The code stubs will be created

i build.gradle (TransferMFT) £ TransferMFT. java
public class TransferNFT [
}

Validate project configurations, see Intelli) step 9. Project configurations will resemble the image
below.



9 Run/Debug Configurations

+ — B HNK
v Application Name: TransferNFT Store as project file
TransferNFT

Runon:  # Local machine v Manage targets..

Run configurations may be executed locally or on a target: for
example in a Docker Container or on a remote host using SSH.

Build and run Modify options ~  Alt+M

java 11 SDK of 'Tra n | -cp TransferNFT.main v
TransferNFT

Program arguments

Press Alt for field hints

Working directory: C:\Users\jim\IdeaProjects\TransferNFT

Environment variables:

Separate variables with semicolon: VAR=value; VAR1=value1

Enable EnvFile
Substitute Environment Variables (${FOO} / ${BAR:-default} / $${ESCAPED})
Process JetBrains path macro references (SPROJECT_DIRS)
Ignore missing files
Enable experimental integrations (e.g. Gradle) - may break any time!

Edit configuration templates...

? “ Cancel Apply

Update the dependencies

Click the Gradle button in the upper right corner, and then click the Reload All Gradle Projects button.

Gradle

+ -
“ | Relead All Gradle Projects

-
ry

a|peIn) !

=]
> 1'% build 5
» 15 build setup g
» '3 documentation @
» [0 help
> [ other
»

= werification

~ Uil Dependencies

il compileClasspath

il runtimeClasspath

il testCompileClasspath

WOW W W

i testRuntimeClasspath

Once the update is complete, click the Gradle button in the upper right corner again to close.



build.gradle (TransferNFT) e TransferNFT.java
import com.hedera.hashgraph.sdk.*;
import io.github.cdimascio.dotenv.Dotenv;
import java.nio.charset.StandardCharsets;
import java.util.=;
import java.util.concurrent.TimeoutException;

» public final class TransferNFT {

private static final AccountId OPERATOR_ID = Accountld.fromString(Objects.requireNonNull(Dotenv.load().get("MY_ACCOUNT_ID")});
private static final PrivateKey OPERATOR_KEY = PrivateKey.fromString(Objects.requireNonNull(Dotenv.Lload().get("MY_PRIVATE_KEY")));

private static final String HEDERA_NETWORK = Dotenv.load().get( envName: "HEDERA_NETWORK", defValue: "testnet");

private TransferNFT() {

+

> public static veid main(String[] args) throws TimeoutException, PrecheckStatusException, ReceiptStatusException {
Client client = Client.forName(HEDERA_NETWORK);

client.setOperator (OPERATOR_ID, OPERATOR_KEY);

Enter the source code from GitHub: TransferNFT 1.txt,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera_3_NFTTokensExercise3/Transfer
NFT_1.txt

Create an account for Alice and Bob and output the results. Set the HBar initial supply to 10.
Create the token for the NFT. Name it TBA NFT and set the symbol to TBA-NFT.

Set the token type is non fungible token unique, set the admin, supply and treasury, to Alice’s private
key. Get a receipt for reporting.

Output the token ID to the console.

Use Get token info to create an object to query the token type and output the token type to the
console.

Refer to the solution on GitHub: TransferNFT 2.txt,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera_3 NFTTokensExercise3/Transfer
NFT_2.txt

As always, if needed, click the Gradle button in the upper right corner, and then click the Reload All
Gradle Projects button.

You project should appear as shown below. The screenshot below shows only the new code added.
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PrivateKey aliceKey = PrivateKey.generate();

AccountId aliceId = new AccountCreateTransaction()
.setInitialBalance(new Hbar( amount 10)) AccountCreateTransaction
.setKey(aliceKey)

.freezeWith(client)
.sign(aliceKey)

.execute(client) TransactionResponse
.getReceipt(client) TransactionReceipt
.accountId;

PrivateKey bobKey = PrivateKey.generate();

AccountId bobId = new AccountCreateTransaction()
.setInitialBalance(new Hbar( amount 18)) AccountCreateTransaction
.setkey(bobKey)

.freezeWith(client)

.sign(bobKey)

.execute(client) TransactionResponse
.getReceipt(client) TransactionReceipt
.accountId;

System.out.println("Alice account ID: " + aliceld);
System.out.println("Bob account ID: " + bobId);

TokenId tokenId = new TokenCreateTransaction()
.setTokenName("TBA NFT") TokenCreateTransaction
.setTokenSymbol("TBA-NFT")
.setTokenType(TokenType . NON_FUNGIBLE_UNIQUE)

.setAdminKey(aliceKey) // so that we con delete later on
.setSupplyKey(aliceKey) // so thot we can mint later on
.setTreasuryAccountId(aliceId)

.freezeWith(client)

.sign(aliceKey)

.execute(client) TransactionResponse
.getReceipt(client) TransactionReceipt
.tokenId;

System.out.println("NFT Token ID: " + tokenId);
TokenInfo tokenInfo = new TokenInfoQuery()
.setTokenId(tokenId)

.execute(client);

System.out.println(tokenInfo.tokenType);



Run the Application

Click Run -> Run ‘TransferNFT”

m File Edit View Mavigate Code Refactor

TransferMFT = src =~ main = java

I Project =

=

I ¥ .gradle
by Jidea
> build
¥ gradle
e &rc

" TransferNFT

o

Build

Debug TransferMFT'

Tools

VC5 Window Help

L Run 'TransferMFT with Coverage

" e
m TransferMNFT C:\Users\jim'/deaProjects\TransferM @ Run

[=

Run...

# Debug..
# Profile...

fj Attach to Process...

TransferBFT - T

Shift+F9

TransferMFT with "Windows Async Profiler' >

Alt+5hift+F10
Alt+Shift+F9

Ctrl+Alt+F35

The results will appears as shown below. Ignore the warnings: [hedera-sdk-7] WARN
com.hedera.hashgraph.sdk.TransactionReceiptQuery.

10:49:22 AM: Executing task ':TransferNFT.main()'...

> Task :compileJava UP-TO-DATE
> Task :processResources NO-SOURCE
> Task :classes UP-TO-DATE

> Task :TransferNFT.main()

[hedera-sdk-7] WARN com.hedera.hashgraph.sdk.
[hedera-sdk-3] WARN com.hedera.hashgraph.sdk.
[hedera-sdk-6]1 WARN com.hedera.hashgraph.sdk.
[hedera-sdk-2] WARN com.hedera.hashgraph.sdk.
[hedera-sdk-6]1 WARN com.hedera.hashgraph.sdk.

Alice account ID: 8.0.2841611
Bob account ID: 0.8.2841612

[hedera-sdk-1] WARN com.hedera.hashgraph.sdk.
[hedera-sdk-4] WARN com.hedera.hashgraph.sdk.
[hedera-sdk-1] WARN com.hedera.hashgraph.sdk.

NFT Token ID: 8.0.2841613
NON_FUNGIBLE_UNIQUE

Deprecated Gradle features were used in this

TransactionReceiptQuery -
TransactionReceiptQuery -
TransactionReceiptQuery -
TransactionReceiptQuery -
TransactionReceiptQuery -

TransactionReceiptQuery -
TransactionReceiptQuery -
TransactionReceiptQuery -

Retrying
Retrying
Retrying
Retrying
Retrying

Retrying
Retrying
Retrying

build, making it incompatible with

node
node
node
node
node

node
node
node

Gradle

o o o o @
o o o o o
[ = = A ]

o @ @

@
I~

8.0.

in
in
in
in
in

in
in
in

250 ms
500 ms
250 ms
500 ms

250 ms after failure during attempt #1:
580 ms after failure during attempt #2:

after
after
after
after

fallure during attempt #1:
failure during attempt #2:
failure during attempt #1:
failure during attempt #2:
1688 ms after failure during attempt #3:

0K
0K
0K
0K

0K
0K

1000 ms after failure during attempt #3: OK

You can use '--warning-mode all' te show the individval deprecation warnings and determine if they come from your own scripts or plugins.

See https://docs.gradle.org/7.1/userquide/command_line_interface.html#sec:command_line_warnings

BUILD SUCCESSFUL in 7s
2 actionable tasks: 1 executed, 1 up-to-date

18:49:30 AM: Task execution finished ':TransferNFT.main()}"'.

Associate the token with Bob so he can transact it.

Create byte arrays with the NFT’s metadata. Then create a byte array list array for the metadata.

Mint the NFT using TokenMintTransaction, https://docs.hedera.com/guides/docs/sdks/tokens/mint-a-

token.
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The TokenMintTransaction will return a long which is the NFT’s serial number.
Based on the serials, this results in NFT IDs: token ID.0, token ID.1, token ID.2 ....

Get the account balances before the token transfer. Use AccountBalanceQuery to return Alice and Bob’s
account balance of NFTs and HBar before the NFT transfer. Query Alice’s and Bob’s account balance and
return it to the console.

Use TransferTransaction to send all the NFTs from Alice to Bob. Also transfer 4 HBar from Bob to Alice.

Use AccountBalanceQuery to return Alice and Bob’s account balance of NFTs and HBar after the
transfer.

Refer to the solution on GitHub: TransferNFT 3.txt,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera_3 NFTTokensExercise3/Transfer
NFT_3.txt

The results will appears as shown below. Ignore the warnings: [hedera-sdk-7] WARN
com.hedera.hashgraph.sdk.TransactionReceiptQuery.

=
@
o

[hedera-sdk-5] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node
[hedera-sdk-1] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node
Alice account ID: 0.0.2844117

Bob account ID: 0.0.2844118

in 580 ms after failure during attempt #2: OK
in 1000 ms after failure during attempt #3: OK

=
=
@
o

[hedera-sdk-4] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.4 in 250 ms after failure during attempt #1: OK
[hedera-sdk-1] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.4 in 5080 ms after failure during attempt #2: OK
[hedera-sdk-3] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.4 in 1800 ms after failure during attempt #3: 0K
NFT Token ID: 0.0.284411%9

NON_FUNGIBLE_UNIQUE

[hedera-sdk-7] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.8.7 in 250 ms after failure during attempt #1: 0K
[hedera-sdk-2] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.8.7 in 580 ms after failure during attempt #2: 0K
[hedera-sdk-5] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node ©.6.7 in 1000 ms after failure during attempt #3: OK

Minting

[hedera-sdk-5] WARN com.hedera.hashgraph.sd
[hedera-sdk-2] WARN com.hedera.hashgraph.sd
[hedera-sdk-6] WARN com.hedera.hashgraph.sd
The NFT has 3 individual parts.

The Alice account balance before is: AccountBalance{hbars=18 ?, tokens={0.0.2844119=3}}

The Bob account balance before is: AccountBalance{hbars=10 ?, tokens={0.0.2844119=0}}

Transfer

[hedera-sdk-7] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.3 in 250 ms after failure during attempt #1: OK

[hedera-sdk-2] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.3 in 5080 ms after failure during attempt #2: OK

[hedera-sdk-6] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.3 in 10800 ms after failure during attempt #3: 0K

Transaction record: tokenID: {[TokenNftTransfer{sender, receiver, seriall}]} {0.0.2844119=[TokenNftTransfer{sender=0.0.2844117, receiver=0.0.2844118, serial=3}]}
Alices's NFT balance after transfer to Bob: {0.0.2844119=0}

Alices's HBar balance after token transfer to Bob: 14 ?

Bob's NFT balance after transfer from Alice: {0.0.2844119=3}

Bob's HBar balance after token transfer from Alice: & ?

=
@
@
@

.TransactionReceiptQuery - Retrying node
.TransactionReceiptQuery - Retrying node
.TransactionReceiptQuery - Retrying node

in 258 ms after failure during attempt #1: OK
in 580 ms after failure during attempt #2: OK
in 1000 ms after failure during attempt #3: OK

=
@
@
@

=
@
@
@
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Interactive Exercise 9

Hedera Schedule Service

Use code in:
https://github.com/theblockchainacademy/Hedera/tree/main/Hedera_7_ScheduleExercise7 and
complete the exercise using the code in the repository.

ﬂ theblockchainacademy

env
HederaSchedule.txt

accounts.txt

D O DO O

build.gradle

Start Itelli) and click New Project. Name the new project HederaScheduleService.
Follow the Environmental Configurations, Intelli) Steps 1 — 8, from the beginning of this document.

Make sure you update the build.gradle file is updated from this GitHub repository. Use your own .env
file with your own account ID and private key. An example is included in this GitHub repository.

Right click on folder src/main/java. Click New -> Java Class.

File Edit View Navigate Code Refactor Build Run Tools VCS Window Help HederaScheduleService - HederaSchedule ja

HederaScheduleService src  main java € HederaSchedule

g Project D =T = & — build.gradle (HederaScheduleService) e K
}?‘ v [ HederaScheduleService ' sers eaProjects\HederaScheduleService public class HederaSc —T
B > M ogradle }

’ Jidea

> gradle

v

src
= main

java

€ HederaSchedule

resources

New >| & Java Class

Ctrl+x P Kotlin Class/File

Ctrl+C | M File



Enter: HederaSchedule

New Java Class

= HederaScheduIe|

I Interface
E Enum

@ Annotation

Paste in the code from:
https://github.com/theblockchainacademy/Hedera/tree/main/Hedera 7 ScheduleExercise?

build.gradle (HederaScheduleService) = .env C’HederaScheduIe.Java = accounts.txt

1 import com.hedera.hashgraph.sdk.*;
2 import io.github.cdimascio.dotenv.Dotenv;

import java.util.concurrent.TimeoutException;
> | public class HederaSchedule {

// HEDERA_NETWORK defaults to testnet if not specified in dotenv

private static final AccountId myAccountId = AccountId.fromString(Dotenv.load().get("MY_ACCOUNT_ID"));

1€ private static finmal PrivateKey myPrivateKey = PrivateKey.fromString(Dotenv.load().get("MY_PRIVATE_KEY"));
11 private static final String HEDERA_NETWORK = Dotenv.load().get( envName: "HEDERA_NETWORK", defvalue: "testnet");

13 p public static void main(String[] args) throws TimeoutException, PrecheckStatusException, ReceiptStatusException {

15 //Create your Hedera testnet client
16 Client client = Client.forTestnet();
17 client.setOperator(myAccountId, myPrivateKey);

1 // Generate a new key pair
26 PrivateKey newAccountPrivateKey = Privatekey.generate();
21 PublicKey newAccountPublicKey = newAccountPrivatekey.getPublicKey();

23 //Create new account ond assign the public key

24 TransactionResponse newAccount = new AccountCreateTransaction()
25 .setKey (newAccountPublicKey)

26 .setInitialBalance( Hbar.fromTinybars(1000))

27 .execute(client);

29 // Get the new account ID

AccountId newAccountId = newAccount.getReceipt(client).accountId;
32 System.ovt.println("The new account ID is: " +newAccountId);
//Check the new account's balance

35 AccountBalance accountBalance = new AccountBalanceQuery()
.setAccountId(newAccountId)

37 .execute(client);

System.ovt.println("The new account balance is: " +accountBalance.hbars);
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" build.gradle (HederaScheduleService) i NV & HederaSchedule,java i accounts.txt
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//5chedule a tronsoction

TransactionResponse scheduleTransaction = new ScheduleCreateTransaction()
.setSchedvledTransaction(sendHbar)
.execute(client);

//Get the receipt of the transaction
TransactionReceipt receipt = scheduleTransaction.getReceipt(client);

J/Get the schedule ID
Scheduleld scheduleld = receipt.scheduleld;
System.out.println("The schedule ID is " +scheduleld);

J/Get the scheduled tronsoction ID
TransactionId scheduledTxId = receipt.scheduledTransactionId;
System.out.println("The scheduled transaction ID is " +scheduledTxId);

//Submit the first signatures
TransactionResponse signaturel = new ScheduleSignTransaction()
.setScheduleld(scheduleld)
.freezeWith(client)
.sign(myPrivateKey)
.execute(client);

//Verify the traonsaction was svccessful and submit a schedule info request
// TransactionReceipt receiptl = signaturel.getReceipt(client);
// System.out.println("The tronsaction stotus is " +receiptl.stotus);

ScheduleInfo queryl = new ScheduleInfoQuery()
.setScheduleld(scheduleld)
.execute(client);

//Confirm the signaoture was odded to the schedule
System.out.println(gueryl);

//5ubmit the second signoture
TransactionResponse signature? = new ScheduleSignTransaction()
.setScheduleId(scheduleld)
.freezeWith(client)
.sign(myPrivateKey)
.execute(client);



97 System.ouvt.printin(guery2);

//6et the schedvled transaction record
TransactionRecord scheduledTxRecord = TransactionId.fromString(scheduledTxId.toString()).getRecord(client);
181 System.ovt.println("The scheduled transaction record is: " +scheduledTxRecord);

Run HederaSchedule

Click: Run (menu) -> Run ‘HederaSchedule’

JTools VCS Window Help HederaScheduleService - HederaS¢

Run 'HederaSchedule' Shift+F10
£+ Debug 'HederaSchedule' Shift+F9
U} Run 'HederaSchedule' with Coverage
(b Run 'HederaSchedule' with "Windows Async Profiler ?

The results should resemble what is shown below:

11:11:12 AM: Executing task ':HederaSchedule.main()'...

> Task :compileJava UP-TO-DATE
> Task :processResources NO-SOURCE
> Task :classes UP-TO-DATE

> Task :HederaSchedule.main()

[main] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node ©.8.6 in 256 ms after failure during attempt #1: OK

The new account ID is: 0.0.30873619

The new account balance is: 1808 t?

[main] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.8.5 in 258 ms after failure during attempt #1: OK

[main] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.5 in 500 ms after failure during attempt #2: OK

The schedule ID is 0.8.38873620

The scheduled transaction ID is 0.0.2084028@1646669466.1848972167scheduled

ScheduleInfo{scheduleId=0.0.30873620, creatorAccountld=0.0.2084028, payerAccountId=0.0.2084028, signatories=KeyList{threshold=null, keys=[302a300506032b6570032100665edb671816
ScheduleInfo{scheduleId=0.68.38873620, creatorAccountId=0.0.2084028, payerAccountId=0.0.2084028, signatories=KeylList{threshold=null, keys=[3082a3008500032b65708032100665edb671816
The scheduled transaction record is: TransactionRecord{receipt=TransactiocnReceipt{status=SUCCESS, exchangeRate=ExchangeRate{hbars=30000, cents=627366, expirationTime=2022-03-

Deprecated Gradle features were used in this build, making it incompatible with Gradle 8.0.
You can use '--warning-mode all' to show the individual deprecation warnings and determine if they come from your own scripts or plugins.

See https://docs.qradle.orq/7.1/userquide/command_line_interface.nhtml#sec:command_line_warnings

BUILD SUCCESSFUL in 6s
2 actionable tasks: 1 executed, 1 up-to-date
11:11:19 AM: Task execution finished ':HederaSchedule.main()'



Interactive Exercise 10

The Hedera File Service

Use code in:
https://github.com/theblockchainacademy/Hedera/tree/main/Hedera_4_FileServiceExercise4 and
complete the exercise using the code in the repository. Iteratively complete the exercise using files
FileService_partl.txt to FileService_part3.txt.

<% theblockchainacademy

env
FileService,java

FileService_part1.txt
FileService_part2.txt
FileService_part3.txt

accounts.txt

(I R R o R i A v R

build.gradle



Start ItelliJ and click New Project called FileService

Follow the Intelli) Steps 1 — 7, from assignment 1. Make sure the .env and build.gradle files are updated.
You may copy paste in the .env file and build.gradle files from the previous exercises or from the GitHub
repository. The same .env and build.gradle files are required.

Make sure you update the build.gradle file is updated from this GitHub repository. Use your own .env
file with your own account ID and private key. An example is included in this GitHub repository.

New Project X

Mame: | FileService]

Location:  ~\lIdeaProjects\FileService

b Artifact Coordinates

Previous ml Cancel Help




In the prerequisites section, a file called account.txt was created. The accounts.txt file was stored in a
directory called hederaTraining.

Open the directory and copy the accounts.txt file.

| = | C\hederaTraining

Home Share View

« v 4 > This PC » Windows (C:) » hederaTraining

hederaTraining ~ [ Name

accounts.bxt

Open
Print

Edit

Share with Skype
Import to Grammarly
Add to IPFS

Upload to CloudApp

®FEO

Move to OneDrive

Eip

Edit with Notepad++

Send with Transfer...

Scan
Shred

b|j@ala

Share
Open with >

Restare previous versions

Send to >

Cut

Copy




Paste the accounts.txt file into the top level of the FileService project.

m Eile Edit View Navigate Code Refactor Build Run Jools

FileService build.gradle

PR S O ®
-E‘ V .%Er“'ce |::-'| Rl BT I PR & PR ) P e
L 7 .gradle New
3 idea Add Framework Support...
* gradle K Cut
hd SrC B Copy
> 5 mai

build.grad Find Usages
gradlew Find in Files...
= gra-#lewba Replace in Files...
settings.gri Analyze
> Il External Librar

Refact
» Uy Scratches and LaEae

Validate the file, the source directory, and the destination (to directory) directory.

Click OK.

B Copy

Copy file CAhederaTraining\accounts.txt

Mew name: accu:uunts.txﬂ

Te directory: | C\Users\jim'\ldeaProjects\FileService ]

Use Ctrl+5pace for path completion

? Open in editor

The accounts.txt file will appear in the project.




~ g FleService C\Users\jim\ldeaProjects\FileService
» Jgradle
» Jidea
> gradle
h 5rC
# [y main
> g test
build.gradle
gradlew
= gradlew.bat
settings.gradle
> Il External Libraries

# "y Scratches and Consoles

The accounts.txt file will open when pasted into the FileService project. Close the file when you are done
validating it.

Project + BT - & a:cauntsml l

~ I FileService C:\Users\jim'\ldeaProjects\FileSer Download grammar and spelling checker for Swedish?
> .gradle I
: ;::‘E "operator”: {
v B "accountId": "0.0.2084028",
> Wgmain "publicKey": "302a300506032b6570052100d52d7e55de28c69527e2a7d145b717df0752f6e14499801b%e42a3ccbatalss7",
> Matest "privateKey": "302e020100300506032b65700422042007049e4530795dF7a79e7F3c0583db0a104c4c18de68dF719FF1b89a0c658DCS"
= accounts.txt },
build.gradle "network": {
gradlew "0.testnet.hedera.com:50211": "0.0.3",
= gradlew.bat "1.testnet.hedera.com:50211": "0.8.4",
settings.gradle "2.testnet.hedera.con:50211": "0.0.5",
7 I External Libraries "3.testnet.hedera.com:50211"; "0.0.6"
> “p Scratches and Consoles }
i

Create a new class called FileService
In the project expand \src\main
Right click on \src\main\java, and click New -> Java Class

m File Edit View Mavigate Code Refactor Build Run Tecols VC5 Window Help FileService

FileService = src = main Java
o Project = E = | o —
- & FileService leaProjects e
In ’ .gradle
> .idea
> gradle
e src

Java Class
& Kotlin Class/File

Ctrl+X
Criec B File
2 Scratch File Ctrl+Alt+Shift+ Insert

Ctrl+V Package

Altep7 B package-info.java

[ T P



Enter the class name: FileSerivce and tap enter key.

Mew Java Class

S FileService

I |nterface
E Enum

@ Annotation

The FileService.java file will open.

Validate project configurations, see Intelli) step 9. Project configurations will resemble the image below.

# Run/Debug Configurations X
+ - EBHR
~ Application Name:  FileService Store as project file
FileService
Runon: M Local machine - Manage targets.

Run configurations may be executed locally or on a target: for
example in a Docker Container or on a remote host using SSH.

Build and run Modify options ~ Alt+M
java 11 SOK of 'FileService.main -  -cp FileService.main -
FileService

Program arguments

Press Alt for field hints
Working directory: C\Usersyjim\ldeaProjects\FileService

Environment variables:
Separate variables with semicolon: VAR=value; VAR1=value1
Enable EnvFile
Substitute Environment Variables (${FOO} / ${BAR:-default} / S${ESCAPED})
Process JetBrains path macro references (SPROJECT_DIRS)
Ignore missing files

Enable experimental integrations (e.g. Gradle) - may break any time!
Edit configuration templates...

? “ Cancel Apply




At the top of the FileService.java file, enter all the import libraries shown below.

import com.hedera.hashgraph.sdk.*;
import io.github.cdimascio.dotenv.Dotenv;
import com.google.protobuf.ByteString;

import Jjava.io.File;

import java.io.IOException;

import java.nio.file.Files;

import Jjava.nio.file.Paths;

import Jjava.security.NoSuchAlgorithmException;
import java.util.concurrent.TimeoutException;

Update the Gradle dependencies.

Click the Gradle button in the upper right corner. Click the Refresh Gradle Project button.

Gradle

S [+ -

Il

T xay

Reload All Gradle Projects

il Dependencies
il compileClasspath
il runtimeClasspath
Il com.goegle.code.gson:gson:2.8.8
com.goagle.errorproneerror_prone_corei 9.0
com.hedera.hashgraph:sdk:2.1.0

io.grpcgrpc-netty-shaded:1.40.1

I
I
Il io.github.cdimascio:;java-dotenv:3.2.1
I
Il org.sifdj:sifdj-simple:1.7.32

il testCompileClasspath
il testRuntimeClasspath

Close the Gradle tools, click the button in the upper right corner.



Create a main function as shown below.

Declare a string variable for the filename accounts.txt

& FileServicejava
import com.hedera.hashgraph.sdk.;
import io.github.cdimascio.dotenv.Dotenv;
import com.google.protobuf.ByteString;

import java.io.File;

import java.io.IOException;

import java.nio.file.Files;

import java.nio.file.Paths;

import java.security.NoSuchAlgorithmException;

import java.util.concurrent.TimeoutException;
b public class FileService {

> public static void main(String[] args) throws TimeoutException, PrecheckStatusExceptien, ReceiptStatusException, IOException, NoSuchAlgorithmException {

string myFile = "accounts.txt";

Run the FileService project.

Click Run -> Run ‘FileService’

Shift+F10

The output will appear as similar to what is shown below

Task :compiledava

Task :processResources NO-SOURCE

Task :classes

Task :FileService.main()

Deprecated Gradle features were used in this build, making it incompatible with Gradle 8.6.

You can use '--warning-mode all' to show the individual deprecation warnings and determine if they come from your own scripts or plugins.

See https://docs.gradle.ora/7.1/userquide/command_line_interface.html#sec:command_line_warnings

BUILD SUCCESSFUL in 829ms
2 actionable tasks: 2 executed
3:51:38 PM: Task execution finished ':FileService.main()'.

Refer to the solution in GitHub: FileService partl.txt,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera_4_FileServiceExercise4/FileServi
ce_partl.txt



about:blank

Part 2

Create a file object from the accounts.txt file. Since the accounts.txt file is at the project level, the path
to the accounts.txt file is ./ there we do not have to prefix a path to the accounts.txt filename.

Use the source code below

String myFile = "accounts.txt";

//pass the filename as a File object
File f = new File (myFile);

String content = Files.readString(Paths.get(myFile));

This is a standard 10 operation for files.

&' FileService java
import com.hedera.hashgraph.sdk.*;
import io.github.cdimascio.dotenv.Dotenv;
import com.google.protobuf.ByteString;

import java.io.File;
import java.io.IOException;
import java.nio.file.Files;
import java.nio.file.Paths;
import java.security.NoSuchAlgorithmException;
import java.util.concurrent.TimeoutExceptien;
b public class FileService {
> public static void main(String[] args) throws TimeoutException, PrecheckStatusException, ReceiptStatusException, IOException, NoSuchAlgorithmException {
String myFile = "accounts.txt";

pass the filename as a File object

File f = new File(myFile);

String content = Files.rewodString(Paths.get(myFile));

Run the FileService project.

Click Run -> Run ‘FileService’

Shift+F10




The output will appear as similar to what is shown below

> Task :compileJava

> Task :processResources NO-SOURCE

> Task :classes

> Task :FileService.main()

Deprecated Gradle features were used in this build, making it incompatible with Gradle 8.8.

You can use '--warning-mode all' to show the individual deprecation warnings and determine if they come from your own scripts or plugins.

See https://docs.gradle.orq/7.1/userquide/command_line_interface.html#sec:command_line_warnings

BUILD SUCCESSFUL in 829ms
2 actionable tasks: 2 executed
3:51:38 PM: Task execution finished ':FileService.main()'.

Refer to the solution in GitHub: FileService part2.txt,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera_4_FileServiceExercise4/FileServi
ce_part2.txt

Part 3
1. Obtain your account ID and private key form the .env file
2. Create a client from the Hedera testnet,
3. Setyour account ID and private for the testnet client.
4. Generate a new public and private key pair.
5. Use FileCreateTransaction to create a file transaction that sets: the file private key, a file key, a

file memo, set the file contents using the file object.

6. Call setMaxTransactionFee on the transaction object to change the default max transaction fee
to 2 hbars.

7. Prepare transaction for signing, sign with the key on the file, sign with the client operator key
and submit to a Hedera network.

8. Confirm the transaction fee by requesting a receipt by calling getReceipt on the transaction
response.

9. Get the file ID by calling fileld on the receipt object. Return the file ID to the console.

10. Get the file contents by calling getContents on the transaction object created in step 5.

11. Return the contents to a string and out put it to the console, the output may be abridged.

12. Use FileInfoQuery to query the file on the network for information.

13. Out the query information to the console. It will be abridged.

Refer to the solution on GitHub: FileService part3.txt,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera 4 FileServiceExercise4/FileServi

ce part3.txt



about:blank
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The output will appear similar to what is shown below.

> Task :classes

> Task :FileService.main()
[hedera-sdk-7] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node B.6.4 in 256 ms after failure during attempt #1: OK

[nedera-sdk-3] WARN com.hedera.hashgraph.sdk.TransactionReceiptuery - Retrying node B.8.4 in 580 ms after failure during attempt §2: OK

The new file I0 is: 0.0.2900216

\'0.8

The new file contents is: <ByteString@5dls5%ea size=520 contents="{\r\n \"operator\*: {\r\n \"accountlo\*:

File response: FileInfo{fileld=0.0.2900216, size=520, expirationTime=2022-01-18T22:00:02Z, isDeleted=false, keys=KeyList{ 1, keys=[ b657003! '1816264ce2a3892f 70 fOc87hSesd

Deprecated Gradle features were used in this build, making it incompatible with Gradle B.0.

You can use '--warning-node all' to show the individual deprecation warnings and determine if they come from your own scripts or plugins.

See hitps://docs.gradle.orq/7.1/vserquide/command Line interface.htmlé#sec: connand, line warnings

BUILD SUCCESSFUL in 3s
2 actionable tasks: 2 executed
6:80:05 PM: Task execution finisned ':Fileservice.main()*



Interactive Exercise 11

The Hedera Consensus Service

Use code in:

https://github.com/theblockchainacademy/Hedera/tree/main/Hedera_5_ ConsensusServiceExercise5
and complete the exercise using the code in the repository. Iteratively complete the exercise using files
HederaConsensusService_partl.txt to HederaConsensusService_part5.txt.

& theblockchainacademy

HederaConsensusService_part1.txt

HederaConsensusService_part2.txt

D
D
[ HederaConsensusService part3.txt
[ HederaConsensusService_part4.txt
D

HederaConsensusService_part5.txt

Start ItelliJ and click New Project called ConsensusService

Follow the Intelli) Steps 1 — 7, from assignment 1, or the previous exercise. Make sure the .env and
build.gradle files are updated. You may copy paste in the .env file and build.gradle files from the
previous exercises. The same .env and build.gradle files are required.

Make sure you update the build.gradle file is updated from this GitHub repository. Use your own .env
file with your own account ID and private key. An example is included in this GitHub repository.

Copy X
Copy file C\Users\jim\ldeaProjects\HederaAPI\.env
MNew name: .env{

To directory: | C:\Users\jim'\ldeaProjects\Consensus5ervice A

Use Ctrl+Space for path completion

? Open in editor “ Cancel




Create a new class called HederaConsensusService
In the project expand \src\main
Right click on \src\main\java, and click New -> Java Class

m File Edit View Navigate Code Refactor Build Run Tools

VC5 Window Help

Consensusbervice - build.gra

build.gradle (ConsensusService)

ConsensusService src = main java
§ [ Project v O & -
E v Mg ConsensusService C\Users\jim'ldeaProjects\ConsensusService
L > .gradle

» Jidea

* gradle

src

tri+ X

Ctrl+C
Ctrl+V
Find Usages Alt+F7
Find in Files... Ctrl+Shift+F
Renlare in Files... Ctrl+Shift+R

Enter HederaConsensusService and tap the enter key.

Mew Java Class

£ HederaConsensusservi cel

I |nterface
E Enum

@ Annotation

The HederaConsensusService class file will open.

£ HederaConsensusService,java

- hiuild anndla £i1a
J/start bulild.gradle flle

plugins {
id 'java'

group 'org.example’
Java Class
& Kotlin Class/File
= File

£ Scratch File

Package

Ctrl+Alt+Shift+ Insert

3 package-info.java
3 module-info.java

w HTML File

public class HederaConsensusService [{

}



Validate project configurations, see Intelli) step 9. Project configurations will resemble the image below.

ﬂ Run/Debug Configurations X
+ - BAMNK
v = Application Name:  HederaConsensusService Store as project file
HederaConsensusService
Runon: A Local machine v Manage targets...

Run configurations may be executed locally or on a target: for
example in a Docker Container or on a remote host using SSH.

Build and run Modify options ~ Alt+M
java 11 SOK of 'ConsensusServ +  -cp ConsensusService.main -

HederaConsensusService

ram argume
Press Alt for field hints

Working directory: C:\Users\jim\ldeaProjects\ConsensusService

Environment variables:
Separate variables with semicolon: VAR=value; VART=value1l
Enable EnvFile
Substitute Environment Variables (${FOO} / ${BAR:-default} / $${ESCAPED})
Process JetBrains path macro references (SPROJECT DIRS)
Ignore missing files

Enable experimental integrations (e.g. Gradle) - may break any time!
Edit configuration templates...

? “ Cancel Apply

import com.hedera.hashgraph.sdk.*;

import com.google.protobuf.ByteString;

import io.github.cdimascio.dotenv.Dotenv;
import java.util.concurrent.TimeoutException;

Create the main method as shown below.

public static void main(String[] args) throws TimeoutException,
PrecheckStatusException, ReceiptStatusException {



Update the Gradle dependencies.

Click the Gradle button in the upper right corner. Click the Refresh Gradle Project button.

Gradle

+ ﬁ =

Il

= e | A
Reload All Gradle Projects
il Dependencies
il compileClasspath
il runtimeClasspath
Il com.goegle.code.gson:gson:2.8.8
Il com.goegle.errorprone:error_prone_core:2.9.0
Il com.hedera.hashgraph:sdk:2.1.0
Il io.github.cdimascio:;java-dotenv:5.2.1
Il io.grpc:grpe-netty-shaded:1.40.1
Il org.sifdj:sifdj-simple:1.7.32
il testCompileClasspath
il testRuntimeClasspath

Close the Gradle tools, click the button in the upper right corner.



The class file should look similar to the image below.

& HederaConsensu sService,java

1 import com.hedera.hashgraph.sdk.*;

2 import com.google.protobuf.ByteString;

3 import io.github.cdimascio.dotenv.Dotenv;
import java.util.concurrent.TimeoutException;

» public class HederaConsensusService {

> public static void main(String[] args) throws TimeoutException, PrecheckStatusException, ReceiptStatusException {



Obtain your account ID and private key form the .env file

Create a client from the Hedera testnet,

Set your account ID and private for the testnet client.

Use TopicCreateTransaction to create a transaction object and call setSubmitKey,
setTopicMemo, and setAdminKey

On the transaction object, call execute client. This creates a transaction response object.
Get a transaction receipt. Call the getReceipt method on the transaction response object.
7. To return the topic ID, call the topicID method on the receipt object and output it to the
console.

PwnNPR

o w

Refer to the solution on GitHub: HederaConsensusService partl.txt,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera_5_ ConsensusServiceExercise5/H
ederaConsensusService_partl.txt

The output will appear similar to below

3:33:09 PM: Executing task ':HederaConsensusService.main()'...

> Task :compileJava
> Task :processResources NO-SOURCE
> Task :classes

> Task :HederaConsensusService.main()

[hedera-sdk-6]1 WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.6.3 in 250 ms after failure during attempt #1: OK
[hedera-sdk-0] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 08.6.3 in 5080 ms after failure during attempt #2: OK
[hedera-sdk-4] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.8.3 in 18080 ms after failure during attempt #3: OK

The new topic ID is 0.0.2908164

Deprecated Gradle features were used in this build, making it incompatible with Gradle 8.0.
You can use '--warning-mode all' to show the individual deprecation warnings and determine if they come from your own scripts or plugins.

See https://docs.gradle.orq/7.1/userquide/command_1line_interface.ntml#sec:command_line_warnings

BUILD SUCCESSFUL in 4s
2 actionable tasks: 2 executed
3:33:14 PM: Task execution finished ':HederaConsensusService.main()'.


about:blank#7.-create-your-first-topic
about:blank

8. Set a message for the topic ID. Use TopicMessageSubmitTransaction set the topic ID to the
newly generated topic ID using the setTopiclD method. Set the message using the setMessage
method.

9. This will create a TopicMessageSubmitTransaction object.

10. Use the TopicMessageSubmitTransaction object and call the getMessage method.

11. Output the message to the console and confirm it was the message passed in.

12. Sign in with the client and start to submit transaction to a Hedera network, transaction
consensus status.

13. Create and submit an account info query to the network. Output the results to the console.

14. Use TopiclnfoQuery to query all topic metadata. Pass in t to the console.

Refer to the solution on GitHub: HederaConsensusService part2.txt,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera 5 ConsensusServiceExercise5/H
ederaConsensusService part2.txt

The output will appear similar to below

3:37:59 PM: Executing task ':HederaConsensusService.main()'...

> Task :compiledava
> Task :processResources NO-SOURCE
> Task :classes

> Task :HederaConsensusService.main()

[hedera-sdk-6] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.0.4 in 250 ms after failure during attempt #1: 0K
[hedera-sdk-8] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.0.4 in 560 ms after failure during attempt #2: 0K
[hedera-sdk-4] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.0.4 in 1008 ms after failure during attempt #3: OK

The new topic ID is 0.8.2908212 ]

The first msg: <ByteString@l755e85b size=48 contents="Good Day and welcome to Hedera Consensus Service">

[hedera-sdk-7] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.0.6 in 250 ms after failure during attempt #1: 0K
[hedera-sdk-3] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.0.6 in 560 ms after failure during attempt #2: 0K
[hedera-sdk-7] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.0.6 in 1606 ms after failure during attempt #3: OK

The transaction consensus status is SUCCESS
TopicInfo{topicId=0.0.2908212, topicMemo=First Message, runningHash=[-128, -56, 91, -14, 66, -10, -68, 127, -124, -37, -60, 113, -124, -69, -65, -27, -25, 123, 59

Deprecated Gradle features were used in this build, making it incompatible with Gradle 8.0.
You can use '--warning-mode all' to show the individuval deprecation warnings and determine if they come from your own scripts or plugins.

See https://docs.qgradle.ora/7.1/userquide/command_line_interface.html#sec:command_line_warnings

BUILD SUCCESSFUL in 7s
2 actionable tasks: 2 executed
3:38:07 PM: Task execution finished ':HederaConsensusService.main()'.
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15. Use TopicUpdateTransaction set the topic ID, the submit and admin keys using the same keys
from the previous part.

16. Get the receipt, status and return the status to the console.

17. Use TopiclnfoQuery to output the updated metadata to the console.

Refer to the solution on GitHub: HederaConsensusService part3.txt,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera 5 ConsensusServiceExercise5/H
ederaConsensusService part3.txt

The output will appear similar to below

> Task :classes

> Task :HederaConsensusService.main()

[hedera-sdk-7] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.0.7 in 250 ms after failure during attempt #1: OK
[hedera-sdk-2] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.0.7 in 580 ms after failure during attempt #2: OK
[hedera-sdk-6] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.0.7 in 1800 ms after failure during attempt #3: OK

The new topic ID is 08.8.2988257

The first msg: <ByteString@1755e85b size=48 contents="Good Day and welcome to Hedera Consensus Service">

[hedera-sdk-1] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.8.4 in 250 ms after failure during attempt #1: 0K
[hedera-sdk-2] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.0.4 in 580 ms after failure during attempt #2: OK

[hedera-sdk-7] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.0.4 in 1800 ms after failure during attempt #3: OK

The transaction consensus status is SUCCESS
TopicInfo{topicId=0.0.2908257, topicHemo=First Message, runningHash=[-72, 91, 186, 51, -118, -52, -53, 54, -104, 91, -50, 51, 16, -22, -115, 119, -10, 22, 100, -34,

Update Topic ------—--=—m—m e e

[hedera-sdk-8] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.0.5 in 250 ms after failure during attempt #1: OK
[hedera-sdk-2] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.0.5 in 560 ms after failure during attempt #2: OK
[hedera-sdk-7] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node £.8.5 in 1808 ms after failure during attempt #3: OK

The transaction consensus status is SUCCESS

The message after the update: <ByteString@1755e85b size=48 contents="Good Day and welcome to Hedera Consensus Service">
TopicInfo{topicId=0.0.2908257, topicl ge memo update, runningHash=[-72, 91, 100, 51, -118, -52, -53, 54, -104, 91, -50, 51, 16, -22, -115, 119, -19, 22,

Deprecated Gradle features were used in this build, making it incompatible with Gradle 8.8.
You can use '--warning-mode all' to shew the individual deprecation warnings and determine if they come frem your own scripts or plugins

See https://docs.gradle.orq/7.1/userquide/command_line_interface.html#sec:command_line_warnings

BUILD SUCCESSFUL in 9s
2 actionable tasks: 2 executed
3:41:34 PM: Task execution finished ':HederaConsensusService.main()'.
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18. Use the TopicMessageSubmitTransaction to submit a new message a to the same topicID .
19. Get the new message for the topic ID and return the new message and metadata to the console.

Refer to the solution on GitHub: HederaConsensusService part4.ixt,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera_5_ConsensusServiceExercise5/H
ederaConsensusService_part4.txt

The output will appear similar to below

[hedera-sdk-0] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.6.3 in 560 ms after failure during attempt #2: 0K
[hedera-sdk-5] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.6.3 in 1000 ms after failure during attempt #3: Ol

=

The new topic ID is 0.0.2908270
The first msg: <ByteString@3fédb3fb size=48 contents="Good Day and welcome to Hedera Consensus Service">
[hedera-sdk-1] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.6.6 in 250 ms after failure during attempt #1: 0K

[hedera-sdk-3] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.0.6 in 500 ms after failure during attempt #2: OK

The transaction consensus status is SUCCESS
TopicInfo{topicId=0.0.2988270, topicMemo=First Message, runningHash=[7é, 98, -18, 97, -64, -116, 22, -46, -30, 187, 66, 68, -72, -97, 111, -48, -98, -87, -B4, -28,

Update TOPIE ~—r--mrmmm oo e e

[hedera-sdk-5] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.6.4 in 250 ms after failure during attempt #1: 0K
[hedera-sdk-0] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.0.4 in 500 ms after failure during attempt #2: OK
[hedera-sdk-4] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 0.6.4 in 1000 ms after failure during attempt #3: OK

The transaction consensus status is SUCCESS

The message after the update: <ByteString@3fodb3fb size=48 contents="Good Day and welcome to Hedera Consensus Service"s
TopicInfo{topicId=0.8.2968270, topicMemo=New message memc update, runningHash=[76, 90, -18, 97, -64, -116, 22, -46, -30, 187, 60, 68, -72, -97, 111, -48, -98, -87,

New message for the same topic --------------mmmmmmom

The new msg: <ByteString@2a2cl3a8 size=46 contents="Time to work with the Hedera Consensus Service"s

TopicInfo{topicId=0.8.2968270, topicMemo=New message memc update, runningHash=[76, 90, -18, 97, -64, -116, 22, -46, -30, 187, 60, 68, -72, -97, 111, -48, -98, -87,
Deprecated Gradle features were used in this build, making it incompatible with Gradle 8.08.

You can vse '--warning-mede all' to show the individval deprecation warnings and determine if they come from your own scripts or plugins.

See https://docs.gradle.orq/7.1/userquide/command_line_interface.htmli#sec:command_line_warnings

BUILD SUCCESSFUL in 8s
2 actionable tasks: 2 executed
3:43:48 PM: Task execution finished ':HederaConsensusService.main()'.
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20. Delete the topic from the Hedera Network. Use TopicDeleteTransaction and call the setTopicld
method with the current topic ID passed into it.

21. Get the TransactionResponse and TransactionReceipt.

22. Return the transaction receipt and the transaction status.

Refer to the solution on GitHub: HederaConsensusService part5.txt,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera_5_ConsensusServiceExercise5/H
ederaConsensusService_part5.txt

The output will appear similar to below.

> Task :HederaConsensusService.main()

[hedera-sdk-7] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node ©.8.4 in 250 ms after failure during attempt #1: OK
[hedera-sdk-3] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.8.4 in 580 ms after failure during attempt #2: OK
[hedera-sdk-7] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.8.4 in 1808 ms after failure during attempt #3: 0K

The new topic ID is 8.8.2988271

The first msg: <ByteString@3fodb3fb size=48 contents="Good Day and welcome to Hedera Consensus Service"s

[hedera-sdk-3] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node ©.8.7 in 250 ms after failure during attempt #1: OK
[hedera-sdk-6] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying nede 8.8.7 in 500 ms after failure during attempt #2: 0K
[hedera-sdk-2] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.8.7 in 1808 ms after failure during attempt #3: 0K

The transaction consensus status is SUCCESS
TopicInfo{topicId=0.0.2908271, topicMemo=First Message, runningHash=[94, -25, 118, -118, -9, 10, -183, 119, 45, -90, -18, -61, 120, -107, 26, -88, -96, 61, -67, 120,

Update TOPiL ------ommommm e e e

[hedera-sdk-5] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.8.3 in 250 ms after failure during attempt #1: OK
[hedera-sdk-8] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.8.3 in 560 ms after failure during attempt #2: OK
[hedera-sdk-3] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.8.3 in 1600 ms after failure during attempt #3: 0K

The transaction consensus status is SUCCESS

The message after the update: <ByteString@3fédb3fb size=48 contents="Good Day and welcome to Hedera Consensus Service"s
TopicInfo{topicId=0.6.2988271, topi ge memo update, runningHash=[94, -25,6 118, -118, -9, 18, -103, 119, 45, -98, -18, -61, 120, -187, 26, -88, -96, 61,

New message for the same topic --------=---=m-mmmemm oo

The new msg: <ByteString@bobl987 size=46 contents="Time te work with the Hedera Consensus Service">
TopicInfo{topicId=0.6.2988271, topi ge memo update, runningHash=[94, -25, 118, -118, -9, 18, -103, 119, 45, -98, -18, -61, 120, -187, 26, -88, -96, 61,

Delete a topic from the METWOPK =--------m oo oo oo oo oo

[hedera-sdk-1] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 8.8.5 in 250 ms after failure during attempt #1: OK
[hedera-sdk-3] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node ©.8.5 in 580 ms after failure during attempt #2: OK
[hedera-sdk-6] WARN com.hedera.hashgraph.sdk.TransactionReceiptQuery - Retrying node 6.8.5 in 1800 ms after failure during attempt #3: 0K
The delete consensus: SUCCESS

Deprecated Gradle features were used in this build, making it incompatible with Gradle 8.0.
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Additional Hands-on Exercises

Create a Token using the JavaScript API
Prerequisites
In order to the JavaScript APl Node.js must be installed.

To install Node.js follow the steps on this site: https://nodejs.org/en/download/

Refer to Hedera documents for JavaScript: https://docs.hedera.com/guides/docs/sdks/tokens/define-a-
token

Create a local directory named: hedera-token-js

Download the Create a token JavaScript application: hashgraph-javascript-token.zip,
https://github.com/theblockchainacademy/Hedera/blob/main/Hedera 6 ExampleExercise6/hashgraph
-javascript-token.zip

Click Download

¥ main ~  Hedera / Hedera_6_ExampleExercise6 / hashgraph-javascript-token.zip Go to file
ﬂ theblockchainacademy Update Latest commit 49ca28d 37 minutes ago CL) History
A 1 contributor

.
e g Y

View raw
(Sorry about that, but we can't show files that are this big right now.)

The application is stored in a zip file, it must be extracted to local directory: hedera-token-js.
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The application will be contained in directory: \hedera-token-js\hashgraph-javascript-token

Run: npm update

EX Administrator: Windows PowerShell

PS C:\hedera-token-js\hashgraph-javascript-token>

dir

Directory: C:\hedera-token-js\hashgraph-javascript-token

Mode LastWriteTime Length
————— 18/29/2021
18/29/2021
10/29/2021
108/29/2021

16/29/2021 11:4: 1968

10/29/2021 11:4: : 13526

10/29/2021 11:41 Ap 618

10/29/2021 11:4: 3347

hedera-token-js\hashgraph-javascript-token>
hedera-token-js\hashgraph-javascript-token>

Name

node modules
.env.sample
.gitignore
LICENSE

main.js
package-lock.json
package.json
README . md

npm update



Install the Hedera JavaScipt SDK package, run:

npm install --save @hashgraph/sdk, or
npm install --save @hashgraph/sdk@latest

Install the dotenv package: npm install --save dotenv,or
npm install --save dotenv@latest

For more information about npm install see: https://docs.npmjs.com/cli/v7/commands/npm-install

The input and output will resemble the image below.

EX Administrator: Windows PowerShell

8/26/2021 10:53 AM 619 package.json
8/26/2021 10:46 AM 3347 README.md

PS C:\Projects\hashgraph-bootstrap-main> npm install @hashgraph/sdk

> protobufjs@6.11.2 postinstall C:\Projects\hashgraph-bootstrap-main\node_modules\protobufjs
> node scripts/postinstall

@hashgraph/sdk@2.0.29
added 30 packages from 61 contributors and audited 30 packages in 5.225s

1 package is looking for funding
run “npm fund® for details

ound @ vulnerabilities
PS C:\Projects\hashgraph-bootstrap-main> npm install dotenv

dotenv@9.o0.2
updated 1 package and audited 30 packages in 0.619s

1 package is looking for funding
run “npm fund® for details

ound @ vulnerabilities

PS C:\Projects\hashgraph-bootstrap-main>




Copy the .env file from the hederaTraining directory to the hedera-token-js\hashgraph-javascript-token
directory.

Use your own .env file with your own account ID and private key. An example is included in this GitHub
repository.

v 41 » This PC » Windows (C:) * hederaTraining

hederaTraining ~  [_Name
HyperledgerFab @IJ_ o ]
M Open with =| accounts.txt

Intel Share with Skype

knowle Import to Grammarly

lenovo Add to IPFS
LQ Upload to CloudApp
LODod *™ Move to OneDrive
magal |di Edit with Notepad-++
Manag %F Send with Transfer...
MattBI o Scan
MattDi 9 Shred
Mattln|
|&” Share

MattS( . .

Restore previous versions
MetaC

Send to >
MewEc
OneDf Cut

—

Origi{; Copy

Paste the .env file to the hedera-token-js\hashgraph-javascript-token directory



hedera-token-js A [ Name

hashgraph-javascript-token node_modules

hederaTraining [ [ env ]

HyperledgerFab "] .env.sample

M | .gitignore

Intel || LICENSE

knowledgeAcadamy 2] mainjs

lenovoCase §J packagejson

Lo 5 package-lockjson
|| README.md

| ONoors

Execute the application, run: node .\main.js

PS C:\hedera-token-js\hashgraph-javascript-token> node .\main.js

The output will resemble the results below. The more the application is run, the more tokens will be
created.

EN Administraton Windows PowerShell

PS C:\hedera-token-js\hashgraph-javascript-token> node .\main.js
Greetings earthling....

This is a JavaScript Hedera API application

Attempting to get token info from the Hedera API...

The token balance(s) for this account: {"©.8.2299317":"

i "‘3.9.3‘339821" :ll 5‘39“ Jl

reating the new TBA Token

new TBA token id: ©.0.3039889 ;)
S C:\hedera-token-js\hashgraph-javascript-token>




Edit the JavaScript application.

Navigate to the hedera-token-js\hashgraph-javascript-token directory. Open the main.js file for editing.

] = | CA\hedera-token-js\hashgraph-javascript-token
Hame Share View
“ v » ThisPC » Windows (C:) * hedera-token-js » hashgraph-j
hedera-token-js A [ MName
hashgraph-javascript-token node_madules
hederaTraining T env
HyperledgerFab | .env.sample
1M | .gitignore
Intel LICEMNSE
212) main,
knowledgehcd [ M 5] mainis ]
Open Json
lenovoCase . .
Edit -lock.json
La .
Open with Command Prompt =
LQDeors Print

magaTree 3 Share with Skype
ManagingBlod [&] Import to Grammarly
MattBlockchai ‘ Add to IPFS
MattDatabase Upload to CloudApp
Mattintermedi ™ Move to OneDrive
MattsOL & Edit with Notepad-+ ]




Scroll to the TokenCreateTransaction() near or on line 55.
Change the name of the token.
Change the initial supply to: 75

Enter “hello” into the console log output.

var createTokenTx = await new TokenCreateTransaction()]

-setTokenName ("Thelen - ")_

.setTokenSymbol (" i
setDecimals (©)

.setInitialSupply (/%) -

setTreasuryAccountId("0.0.2084028")

.setTreasuryAccountId (moperatorId)
.execute(client) ;

var createReceipt = await createTokenTx.getReceipt(client);
var newTokenld = createReceipt.tokenld;

console.log('new B1 : ', newTokenId.toString(), ' ;)'); ]

Save and close the main.js file.

Execute the application, run: node .\main.js

PS C:\hedera-token-js\hashgraph-javascript-token> node .\main.js

Run the application at least twice to output the details of all tokens.
The resulting output will appear similar to the image below.

E']:Il" : “?5“]—

Creating the new TBA Token

new hello TBA token id: @ ;)
PS C:\hedera-token-js\hashgraph-javascript-token>




The Hedera Consensus Service Chat application

Use the code and steps on GitHub to install and configure the Hedera Consensus Service Chat
application.

The Hedera Consensus Service Chat application is a node.js web application.

https://github.com/hashgraph/hedera-hcs-chat-js

EX Administrator: Windows PowerShell

Windows PowerShell

This PC > Local Disk (C:) > hedera-hcs-chat-js-api2 = e . .
[Copyright (C) Microsoft Corporation. All rights reserved.

st Quick access

M Desktop
node_modules

Documents What mode do you want to run in?

public SR e 2 ; wi o5
& Dounlosds What's your account ID? [empty will default to the value at process.env.ACCOUNT_ID]

env

rs\Administrator> cd C:\hedera-hcs-chat-js-api2

images dera-hcs-chat-js-api2> node .\server.js

& Pictures

-env.sample What your private key?

= This pC gitignore [empty will default to the value at process.env.PRIVATE_KEY]

LICENSE [hidden]

package,son Should we create a new topic, or connect to an existing one? (Use arrow keys)

¥ 3D Objects

B Desktop
Documents

# Downloads ) serverjs

& Music ) utitsjs

&= Pictures

B videos

.. Local Disk (C)

package-lockjson
READMEmd Connect to an existing topic

& Network



about:blank

D focalhost

Hedera Chat Demo 4> Topic: 0.0.3039926

The Blockchain Academy

If you have any issues setting up, or running the Hedera HCS chat application, contact: learner-
support@blockchainhub360.com

A link for the application can be sent to you to run it.



Final Exercise

Create an application that satisfies the requirements below.
Send the output, including your name to email: learner-support@blockchainhub360.com

Create a great Hedera application based on what you have learned. Greatly elaborate on the solution.
All solutions are posted anonymously.

Requirement 1:
Create accounts for: Abbey, Bill, and Chuck

Create a fungible token with an initial supply of 100. Make Alice the treasury account. Name the fungible
token.

Send tokens from: Abbey, Bill, and Chuck.

Return the user accounts, the token IDs and names, and the balance of each user’s account.

Requirement 2:
Create an NFT, name it, mint it, and add image metadata.
Send the NFTs to all three account users.

Return the NFT ID, and the balance of each NFT for each user.

Requirement 3:

Upload a file to Hedera. Return the file ID
Set the maximum transaction fee for the file.
Output file contents once it is on the Hedera.

Delete the file.

Requirement 4:

Use the Hedera Consensus Service to create a topic, modify the topic and output the topic message.

Again, send your name and a screenshot of all output to: learner-support@blockchainhub360.com



